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Preface

We created MacRegistrar for teachers who enjoy teaching. Record keeping, especially for
larger courses, can be burdensome. J. B. Bugliari, Dean of the University Faculty at Cornell
University, realized that computers can provide meaningful relief in this situation and
commissioned the creation of this program. University Registrar, Keith Ickes, and Director
of Administrative Computing, Russ Vaught, have been actively involved and supportive in
bringing MacRegistrar to the Faculty. Computing tools are valued at Cornell University.

This program and a machine-readable class list is being provided on request to each member
of the Cornell faculty. Much redundant typing is eliminated, course administrative chores
reduced, and an additional tool for analysis of performance made available.

MacRegistrar provides remarkably easy access to records for data entry, data manipulation
including grade conversions, full annotation, report generation with text and graphical
content, and export of term results to the Registrar in machine-readable form. Additional
flexibility and power comes from the extensive export/import capabilities of MacRegistrar
which permit you to use word processor, spreadsheet, database, and statistical and graphical
tools as extensions to this specialized database.

MacRegistrar can be used with the Macintosh 512E, Macintosh Plus, Macintosh SE, and
Macintosh II. Switcher and Multifinder are supported. We have fully exploited the
established Macintosh User Interface to produce a remarkably intuitive and easy to use, but
powerful, application. Macintosh users with knowledge of only one word processor can read
the overview and the guided tour to become a user of MacRegistrar. Power users should
read the remaining material, especially the discussion of the export/import capability. This
interchange feature allows you to merge data from word processor files or from machine
generated records such as attendance and test scores.

We expect MacRegistrar to be useful with courses having enrollments ranging from 2 to
2,600. Both numerical and non-numerical data can be stored.  Since the Macintosh interface
has been followed, user learning time should be minimal. The data structure provides
particularly compact data storage so even large courses can be handled without sacrificing
simplicity.

Enjoy!

JRC, ETS

October 1987
Ithaca
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MacRegistrar™:
A Specialized Database For Course Information

Chapter 1  Overview of Capabilities

MacRegistrar is a specialized database designed to simplify record keeping traditionally
associated with teaching. It provides many rapid and useful additional techniques to record,
analyze, and report the data without sacrificing flexibility. Chapter 1 provides an overview
of program capabilities. Chapter 2 provides a guided tour of frequently used techniques;
Chapter 3 describes the more specialized capabilities. Chapter 4 is a reference guide for all
commands. The appendices provide technical details needed to customize MacRegistrar.

MacRegistrar provides a framework for maintaining student records:

create class lists,
update class lists,
numerical and letter grade data entry,
free-form note file,
annotation of grades for special circumstances,
review and print class summaries,
create historgams and descriptive statistics,
transfer data between MacRegistrar and statistical, graphical, spreadsheet, and database

programs for additional analysis,
convenient automatic calculation and manual adjustment of term grades, and
manual and machine-readable transfer of term results to the Registrar.

MacRegistrar characteristics:

handles even the largest courses (up to 2,600 students),
uses variable length records for compact files,
user-defined fields and formats,
user-defined column headings,
convenient manual and automatic backup,
open-ended usage with other applications,
requires 128K ROM (Mac 512KE or larger),
adheres to Macintosh User Interface,
supports ImageWriter and LaserWriter, and
works with Switcher and Multifinder.



Summary of Steps

1. Create Course File of Student Records

Small Courses: Create new course file (Course Information, Password);
Create student records (New Record, enter student names and other student information)

Large Courses: Create new course file from machine-readable Registrar file (Import From
Registrar, Password); add miscellaneous student information as desired.

2. Define Fields and Enter Grades

Create user-defined data fields for grades and term results (Change Headings, New Global
Items, Format, Average Format, Grade Format).

Small: Enter grades throughout term (Search, Next, Save)

Large: Enter grades throughout term (Import from Text files, Save).

3. Optional Steps

Examine records (Search, Delete Record, Field Info, Assign Comment, Create Graph, About
Student, Archives, etc.); sort and print summaries (Rank, Sort, Pront Sorted Lists, Fonts);
print all or selected student records (Print Student Record, Fonts); post class lists using
Internal ID.

Small: Update class lists via keyboard

Large: Update class list using machine-readable Registrar file (Import, Archives); transfer
data to other applications for analysis.

4. Term Grades

Calculate term grade (About Student, Show Template, Drop Lowest, Weights, Calc. Average,
Calc Grade); print and distribute term summaries for student verification; post term
summary using Internal Student Identification (Print Sorted Lists); print archival copy (Print
Sorted Lists or Print Student Records).

Small: Send printed results to Registrar

Large: Send terms results to Registrar in machine-readable form (Export to Registrar).



1.1  Data Entry and Storage

Fig 1.1 depicts the initial template of a typical student record. You can include up to 2,500
records in a single course file.

Fig 1.1  Student record format

The top portion of the screen contains the student information supplied by the Registrar—
course name, student name, identification number CUID), social security number (SSN),
student’s class (Cl), student’s college (Col), lecture number (Lec), lab number (Lab), and
section number (Sec); the number of credits (Credit); and the grading option (GrOpt). You
provide the teaching assistant, section leader, paper grader, etc. (TA), and the internal,
course-specific identification number (IntID), which is generated automatically. The
information from the Registrar can be entered by keyboard or read from a computer file.

The remainder of the screen displays the information you enter during the term. The data is
organized into six user-named columns of an arbitrary number of rows. Since initially only
14 rows appear (Fig 1.1) the vertical scroll bar at the left is inactive.

Only those grade entry fields (shaded in the large region at the bottom left of the screen in
Fig. 1.2) which you select from the columns will accept data and be stored on disk; the choice
of fields need not necessarily be the same for every student although that typically is the
case. Initially, only one field in each column is active. You can add fields just below the last
field in a column.



Fields for calculated values, e.g., class ranks, weighted average, and course letter grade, are
located at the bottom right of the screen. You can edit these fields also. The scroll bar located
at the extreme bottom right corner of the screen provides one means of paging through the
collection of student records. In addition, command keys allow you to view the first, last,
next, and previous records of the ordered list. You can perform random searches via a menu
of student names or by typing the initial letter or letters in a student’s name or identification
number.

You can add a descriptive note for each grade entry field in the template (Fig 1.2). For
example, you may wish to indicate the pages or topics covered for each entry. This
description is the same for a given field on every student record. In addition, you can
associate comments with up to five fields in each student record; in Fig 1.2 at the bottom of
the Field Info window we have tagged the highlighted (boldface) grade as a makeup grade.
HW4 appears in boldface and also has an associated comment.

Fig 1.2  Field info and comments

Data entry follows the Macintosh user interface standards familiar to all Macintosh users.
Use the mouse to select a field (i.e., make a field appear with white characters on a black
background, indicating it is ready to accept input). The usual word processor editing
capabilities apply here.

If you wish to add a new record, select New from the Record menu or press command R to
save the current record to disk and to place a blank record template on the screen.



Free-form text (Fig 1.3) may also be associated with each student’s record. Use the scroll bar to
select a record. If you add or delete student records, click Update to make the list in this scroll
window consistent. The Print option allows you to print all text records or just those which
are not empty.

Fig 1.3  Free-form notes for each record

1.2  Data Manipulation and Output

In subsequent sections we present the techniques for calculating class ranks, weighted
averages, and final letter grades. You can route text and graphical output to the screen, to a
printer, or to a file.

There are five principal categories of MacRegistrar output:

1) A composite of all information in each record for each student (Fig 1.1) for student
verification or for archival purposes.

2) Free-form notes (Fig 1.3) for each student.

3) A subset of the fields from each record, displayed in a one-line-per -student format (Fig
1.4), and sorted for summary purposes such as posting of grades and for reviewing trends.

4) Standard text files (Fig 1.5) which you can manipulate in a word processor or by other
standard applications or by a program which you create.

5) Graphical and statistical results (Fig 1.6 and 1.7).



Fig 1.4  Sorted list of selected fields

Albright, G               307446 058784598 1 02 01 01 01 0200 L
Aneshansley, I            310066 907645354 1 03 02 02 02 0200 E
Bart, B                   311957 564654565 2 04 03 04 04 0200 L
Bartsch, E                301814 864654521 3 02 01 06 06 0200 L

Fig 1.5  Exported text files

Fig 1.6  Graphical output



Fig 1.7  Summary values

1.3  Pull-Down Menus

The menu bar across the top of Fig 1.1 lists the pull-down menu options and provides a
concise clue to the usage of MacRegistrar.

In general, the sequence of usage is from left to right along the menu bar.

Fig 1.8  Apple menu

The menu for desk accessories is always first on the menu bar; the first item always provides
information about the application. Here the copyright notice and authors are acknowledged.



Fig 1.9  Copyright notice and credits

The second entry provides access to free-form text notes for each student (Fig 1.3).

As is customary, the File menu (Fig 1.10) provides access to the disk file system. Use this
menu to create a new course file, open any of the existing course files, close an open course
file, import data from another application, export data to a text file for another application
using a user-defined format, specify the manner of the database usage, and print student
records and sorted lists. According to the convention, Quit the application is the last entry.



Fig 1.10  File menu

The import/export capability is a particulary important and powerful feature. You can export
data to a statistical application such as DataDesk™, to a spreadsheet such as Excel™, to a
graphics program such as Cricket Graph™, or to any other application which allows
standard ASCII text file input. The clipboard, of course, can also be used to transfer
information.

This import/export feature also makes the program open-ended. For example, if we have
not included your favorite algorithm for computing the weighted average, simply export the
data to your own Pascal, FORTRAN, C, or other application to handle this transformation
and then import the results.

The Edit menu (Fig 1.11) contains the customary cut, copy, paste, and clear commands. In
addition, you can extend these commands to perform the same operation simultaneously
for the same grade field of all records. The undo command applies to most operations.

The program maintains an index for rapid retrieval of records. If you are a fast typist, disable
the Auto Sort option until you have entered all records.

Fig 1.11  Edit menu

Use the View menu (Fig 1.12) to select the order of viewing records when you scroll through
the class list—either alphabetically by student or by student identification number. If you
select a field before scrolling, the cursor maintains correct placement for input. You can
restrict either of these listings by limiting the list to specific subsets—e.g., teaching or section
leader, class, college, lecture, lab, or section.



Fig 1.12  View menu

Create, delete, and search in an arbitrary order for student records using the Record menu
(Fig 1.13). To retrieve records in index order (by name or by ID) use this menu or the
command key equivalents.

Fig 1.13  Record menu

 Using the Archives... command, you can recover or review deleted records. Similarly, when
you update your class list using files supplied by the Registrar or when you import scores
from a text file created by a word processor or by a machine scoring device, MacRegistrar
forms an archive file. When MacRegistrar cannot make a unique match due to a misspelled
name or a mismatched identification number, it sends the suspect record to an exception
file. You can retrieve, modify, or permanently purge exception file records.



Fig 1.14  Scores menu

To add new items (grade fields) at the end of any column of a record, select the last field in a
column and use New Item of the Scores menu (Fig 1.14). You can also select a field at the
bottom of a column and then delete it with the Delete Item command. Global commands
apply to all existing records. If you later add students, problems in scoring may result unless
New Global Items is applied to the added records.

The Drop Lowest... option permits you to drop a specified number of the lowest grades in
each category when the program computes the weighted average. If you have allowed extra
graded items, you can include only a specified number of the best entries in each column
using the Keep Best... option.

Use Letter Grades... to associate a numerical range of scores with each of the permitted letter
grades. A graphic interface facilitates this process. MacRegistrar will automatically translate
numerical grades if you reformat a field.

Show Template... displays a composite of all fields which have been created.  Each of the
fields used to store grades or calculated values can be formatted with this command.
Use the remaining options under Scores to format the field values. You can set the format
for individually selected fields or for entire columns. You can use either integer or real
numbers with one decimal place; letter grades can be either A+, A, A-, B+, ...F or S/U or any
two characters. The computed Average field can be either integer or decimal. The final grade
can be either a numerical or letter grade. You can edit the grade you calculate using the
Special menu.



Fig 1.15  Special menu

The Special menu (Fig 1.15) controls the manipulation of the data—sorting, ranking, and
weighted averages, including tabular and graphical output. Create customized reports by
selecting the fields and their order. You can sort the output using user-selected columns
such as name, identification number, rank, and weighted average fields.

This menu also includes various housekeeping chores—assigning comments for fields,
changing data column headings, password and course information, as well as automatically
generating a course-specific student identification number (IntID in Fig 1.1) which allows
you to publicly post scores without violating student confidentiality rights.

Fig 1.16  Windows menu

Use the Windows menu (Fig 1.16) to bring the desired window to the front, or, if active,
remove it from the screen. The student template (Fig 1.2) is referred to as Student. Check the
Field Info option (Fig 1.16) to display information about each field you select (Fig 1.2). Sorted
List brings to the foreground the sorted list, provided you have created one using the Special
menu. Graph brings the graphical output to the foreground if any exists. Set the font you
want to use in the displays (except for the Student record screen) and printed output using
the Fonts...  option.



For experienced Macintosh users this brief overview is probably sufficient background to use
MacRegistrar satisfactorily. Many additional features are described in the Reference chapter.
However, less experienced Macintosh users should follow the examples in Chapter 2 for a
detailed tour. Additional techniques which you will need to fully utilize all of the features
appear in Chapter 3.

A Word About Data Security

We recommend that you protect your data by making frequent backups. At frequent
intervals when working with large files use the Save command on the File menu to make a
precautionary backup. When you close a course file, MacRegistrar automatically makes a
backup copy; if you wish to suppress this action, press the Option key when you select the
Quit command on the File menu (Option-Quit).

Always close a file before leaving MacRegistrar; never simply turn the power off, as this will
surely corrupt your files. If you should have a power failure while a course file is open, the
backup file can be substituted for the corrupted file.

Printing a copy of the just-entered grades using the Sort command of the Special menu and
the Print Sorted Lists... of the File menu provides extra protection.  However, routinely keep
a backup of the main file on a separate diskette. Diskette failures are very rare, but do occur.



Chapter 2

A Guided Tour of MacRegistrar

In this chapter we lead you through an examination of a sample data file Intro to Agr Engr
(Fig. 2.1) included on the MacRegistrar distribution disk.

Fig 2.1  MacRegistrar application and data file icons

Note: In this manual we assume that you know how to use a Macintosh word processor and
are familiar with the associated Macintosh conventions.

Before you begin

••• Make a copy of the distribution disk. Store the original and work only with the copy.

If the copy becomes damaged or otherwise unusable, you can make additional copies from
the uncorrupted original. Use the procedures described in your Macintosh user’s guide to
duplicate the original disk. If you are using a hard disk, create a MacRegistrar folder, then
copy the MacRegistrar, Intro to Agr Engr, Intro to Agr Engr.Notes, and the MacRegistrar
ReadMe files into the folder.

Note: Only archival copies are permitted by U.S. copyright law. Refer to the About
MacRegistrar™ notice in the  menu for ordering information if others wish to obtain a
copy.

In the following instructions we assume that you are using the working copy in an internal
disk drive. Let’s assume that the computer has been powered down.

• Place the working copy of MacRegistrar in the internal drive and turn on the power
switch.

After the Welcome to Macintosh message is replaced by the desktop,

• Double-click on the distribution disk icon, and

 you should see the following (and possibly some additional files):



Fig 2.2  Distribution disk window

Load A Course File

• Double click on the icon of the demo course file, Intro to Agr Engr.

This command activates MacRegistrar and loads the demo course file.

Fig 2.3  File menu

Alternatively, you could have clicked on the MacRegistrar icon to activate the application.
Then you would have dragged to Open Course... on the File menu (Fig. 2.3), and released the
mouse button. When the list of files appeared, you could have either clicked on Intro to Agr
Engr and then on the Open button or just double-clicked on Intro to Agr Engr to bring the
first record of hypothetical data to the screen.

Note: If you wish to create a new course file, close this course using Close Course of the File
menu and then select New Course. MacRegistrar prompts you to name the new course, to
provide additional descriptive information, and, optionally, to provide a password.



Fig 2.4  A student record

Modify fields in this record.

Note: The data contained in Fig. 2.4 is called a ‘record’; the individual entries in a student
record are called ‘fields’.

• Click in a grade “field” , e.g., Quiz 4, using the mouse.

A rectangle appears around the grade field, and the entry appears in white on a black
background. You have now selected the field and can edit it.

• Type a new grade to replace the original value.

• Click outside the field to make the box disappear.

Alternatively, you can also position the flashing cursor between two characters and then
backspace to remove characters to the left of the cursor, or you can also drag across text to
select characters for replacement just as you would with a word processor.



Fig 2.5  Edit menu

You can modify any of the fields in this manner. The Cut, Copy, Paste, and Clear commands
under the Edit menu (Fig. 2.5) work just as you would expect from your word processor
experience. The companion commands Cut All, Copy All, Paste All, and Clear All work
exactly the same but apply to the same field in every student record in the course file, not
just the visible record.

Suppose you wish to add another quiz grade.

• Click on the last Quiz field to select the last entry in that column (shown here with its
original value, Fig. 2.6).

Fig 2.6  Select last entry in a column to activate New Item command

• Pull-down the Scores menu (Fig. 2.7) with the mouse and drag to New Item  before you
release the mouse button.



Fig 2.7  Scores menu

Notice that the Scores menu lists an equivalent keyboard command for this same action
(Command I).

This illustrates the flexibility of the student record format; you can add or remove fields at
the end of a column at any time.

Format a Field

• Pull-down the Scores menu with the mouse and drag to Format...  before you release the
mouse button to obtain the Format dialog (Fig. 2.8).

Fig 2.8  Format... command

The format of this new field is the same as the one just above it. To specify the format:

• Click on Decimal.



• Set the numerical range at 0.0 to 100.0.

• Click OK.

• Click in the new field and type a value.

If any data already exists in this field, MacRegistrar gives you an opportunity to erase or to
convert automatically the existing data to conform to the new format. The program
translates the numerical entries to letter grades as specified by the Letter Grades translation
table established using the Scores menu.

Fig 2.9  Letter Grades translation table

Remove a field

To remove the field that you just added:

• If that field is not still selected, select it now, then

• Pull-down the Scores menu with the mouse and drag to Delete Item before you release the
mouse button.



Fig 2.10  Delete Item example

You can remove only the last field in a column. However, you can repeatedly remove the
last field until only one field in a column remains.

Examine the next record.

• Click once on the right arrow at the bottom right corner of the screen (Fig. 2.11).

Fig 2.11  Record scroll bar

The next record appears momentarily. Clicking in the gray area to the right of the box in the
scroll bar advances ten records, just as if you had clicked the arrow ten times. Drag the box to
a new location to scroll even faster.

Keyboard equivalents to Previous, Next, First, and Last (command P, command N,
command F, and command L) on the Record menu also allow you to choose the record you
wish to see.

Fig 2.12  Record menu



Table 2.1  Keyboard commands

Command Action
Q Quit
Z Undo
K Cut
V Paste
R New Record
S Select
P Previous

N Next
F First
L Last
I New Item

M Format

Scroll Filter.

If your class has meaningful subdivisions of TA, Class, College, Lecture, Lab, or Section, you
can limit the scrolling to each of the categories within these fields.

• Pull-down the View menu with the mouse and drag to Section before you release the
mouse button.

Fig 2.13  View menu

MacRegistrar asks you to approve the sorting of the file by this grouping (Fig. 2.14).

Fig 2.14  Sort confirmation message



• Click on the Sort button.

Note: If a large number of records were to be sorted, a progress indicator would also appear.

• Examine the View menu to verify that  Section  is outlined indicating the existence of an
index for quick access.

The dot to the left of Section means that this is also the index in use.

Note: MacRegistrar can store this index with your course file, even after you close the file.
Any addition or deletion of records destroys the index, and the outlining on the Section
option of the menu disappears.

Also note the presence of a double-headed scroll arrow near the record scroll bar (Fig. 2.15).
The text on the shaft of the arrow also indicates that the Section index is active.

Fig 2.15  Scroll filter selector

When you click on the student scroll bar while this filter is active, only student records from
the current section appear.

• Click on the right-hand end of this scroll arrow to select the next sub-category within
Section.

Note that the displayed record shifts to show a record from Section 2. Repeated clicking of
either arrow head causes the subcategory to change in a cycle. If you wish to see all categories
listed at once:

• Click on the shaft of the arrow.
Fig 2.16  Subcategory selection



A menu of subcategories appears (Fig. 2.16):

• Use the scroll bar to examine the entire menu list.

• Click to select a category.

• Click on Select to choose one.

Note: The last two actions can be combined into a double-click.

When you scroll through the list of records using Previous, Next, First, Last, MacRegistrar
now presents only those records which meet the subcategory you just established.

• Click again on Section in the View menu (Fig 2.13) to remove the filter.

Note: You can retrieve student records on the basis of CUID number. When you select by
CUID on the View menu, then Previous, Next, First, and Last refer to the CUID numerical
ordering of the index.

You can locate records in any order using the Search option of the Record menu. Command
S is the keyboard equivalent for this command.

Select an arbitrary record.

• Pull-down the Record menu with the mouse and drag to Search... before you release the
mouse button (Fig. 2.17).
Fig 2.17  Record menu

The three dots after Search... indicate that you must supply additional information to
complete the command. Once more you have several alternatives.



Fig 2.18  Selection window

• Type So and press Return.

Note: Return  accepts keyboard entries; Select accepts scroll bar entries.

• Double-click on Sobel, O to select that record.



Fig 2.19  Filtered list of names

Note: If you type enough characters to uniquely locate a record, MacRegistrar bypasses the
above screen.

Alternatively, you could have clicked on Sobel, O and then on Select.

Just for practice locate another record using another technique.

• Type command S to obtain the menu of names.

• Use the scroll bar at the right to find the name of the student whose record you wish to
retrieve, e.g., Speicher, M.



Fig 2.20  Scroll and double-click to select

• Double-click on the desired name when it comes into view to retrieve the record.

Notice that the cursor remains in the same field as you select different records. This
expedites the grade entry process.

Note: Use New (command R) under Record to add an additional student record; Delete
(intentionally without a keyboard equivalent) removes records. Try it.

Note: MacRegistrar saves deleted records in a delete file. You can retrieve or permanently
remove them using Archives...  of the Record menu.

If you are a fast typist:

• Turn off the automatic indexing by dragging to Auto Sort in Edit.

Remember to re-activate the indexing when you have entered all records.

Notice that two fields (Lab and Paper) are represented by grey rectangles. These fields are
currently available but contain no data.

Assume that “Project” is a better description of an assignment than “Paper”. Rename the
“Paper” column, calling it “Project”



• Pull-down the Special menu with the mouse and drag to Change Headings... before you
release the mouse button (Fig. 2.21).

Fig 2.21  Special menu

• Click in the rectangle at row 4 after the r in Paper  (Fig. 2.22), backspace to delete this
heading, and then enter the new heading (Fig. 2.23).

Fig 2.22  Change column headings



Fig 2.23  Edit heading

Note: You can use the dragging technique to select the entire contents of this entry. Once you
have selected the entry, any typing deletes the current contents.

• Click OK when you have satisfactorily made your change or click on Cancel if you change
your mind.

Saving data

Note: MacRegistrar uses a combination of disk-based and RAM-based storage. File saving is
automatic as soon as you perform an operation. However, MacRegistrar does not write the
end-of-file markers and the resource map until you close the course file. The course file size
can exceed RAM limitations but cannot exceed 2,600 records.

     ALWAYS close the file before you turn the power off.   

Examine the other Windows.

So far we have been examining the contents of complete records. The Windows menu (Fig.
2.24) provides three other views of the data.

Suppose you wish to attach a note to each field to remind you of the material covered and
the date of the exercise.

Fig 2.24  Windows menu

Commentary

• Pull-down the Windows menu with the mouse and drag to Field Info before you release
the mouse button.

A movable, but not re-sizable, window appears (Fig. 2.25).



Fig 2.25  Field Info window

• Place the arrow cursor on the ruled title bar of the Field Info window.

• Drag (keep the mouse button pressed while moving the cursor) the window to the bottom
of the screen to avoid masking the top of the Student window.

• Click on a grade field, e.g., HW 1, and the Field Info window behaves as a word processor
window.

• Type an identifying message, e.g., ‘p1-32 Introduction Ch1’.

• Click in any other field to repeat this process.

Anytime you click on a field when the Field Info  window is visible, the message you
entered appears.

• Click in the small square box at the top left of the Field Info  window to close this window.
Alternatively, again select Field Info  from the Windows menu to move this window
from view.

MacRegistrar allows an additional level of annotation. You can enter up to five (5) stock
messages that you can assign to grade fields. This number should be sufficient for most
situations; the number was deliberately kept small in order to preserve the compact file
structure.

• Pull-down the Special menu (Fig. 2.26) with the mouse and drag to Assign Comment...
before you release the mouse button.



Fig 2.26  Special menu

• Assign messages to these entries, e.g., illness, University travel, religious holiday,
excused, optional project (Fig. 2.27).

You can use these messages with any record in the course file. Once you have used an item,
any subsequent changes apply to all of the records, not just the current record.

Fig 2.27  Assignment of comment choices

• Click OK when finished.

Assign comments to two fields of the current record.



• Click on HW 1 (You must click in a field to enable the following procedure.)

• Pull-down the Special menu (Fig. 2.26) with the mouse and drag to Assign Comment...
before you release the mouse button.

• Click on the radio button adjacent to the appropriate message.

Note: You can select only one of a set of radio buttons, just as the push-buttons on a car radio
allow the selection of only one station at a time.

• Click OK to close the Comment window.

Let’s examine the results of your efforts.

With the HW 1 field still selected,

• Pull-down the Windows menu (Fig. 2.28) with the mouse and drag to Field Info  before
you release the mouse button.

Fig 2.28  Windows menu

If necessary, move the Field Info  window to a non-used part of the screen. The bottom line
of the Field Info  window now displays the comment.

• Click outside the Field Info  window to de-select the grade field with which this message is
associated.

Notice that HW 1 now appears in boldface type (Fig. 2.29) to indicate that a comment has
been associated with this field. You can tag up to five (5) such fields in each student record
with one of these stock messages.

Fig 2.29  Boldface indication of commented entry

• Click the close box of the Field Info window.



You can save detailed commentary on each record.

• Pull-down the Apple menu (Fig. 2.30) with the mouse and drag to About Student... before
you release the mouse button.

Fig 2.30  Free-form text About Student... where records can be stored

Use the scroll box to access the free-form text you create for each student. Critiques of essays
or special circumstances can be noted here (Fig. 2.31). This information can be reviewed
when the course grade is being assigned.

Fig 2.31  Text, (e.g.,paper critiques, special circumstances) can be filed

Interesting and meaningful patterns often emerge from the data if viewed appropriately.
Let’s look at some sorted lists.

• Pull-down the Special menu with the mouse and drag to Sort... before you release the
mouse button.



To assist in the selection of the fields for listing and sorting, the following screen appears
(Fig. 2.32):

Fig 2.32  Window for selection of fields and sorting order

To display sorted lists, select the fields you want to appear on the screen and then select the
fields you want to sort.

Select the fields to appear in the report

At the bottom right of the above figure (Fig. 2.32), List appears as the default.

• Click in the fields (Fig. 2.33) to designate the left-to-right ordering of the fields you wish to
list on each line of the output sent to the screen.

The line length appears across the top of the screen. If you include more fields than the
screen can display, the small arrows at the top-right corner of the screen permit you to see
the entire list. Of course the actual sorted list requires the use of the horizontal scroll bar,
too. You may wish to have the student name appear near the right of the screen so that you
can see the identifying name after the scroll.

Note: To change the order of the fields in the list, simply drag the outline of a field until it
coincides with the field you wish to swap. To de-select a field, simply select it again.



Fig 2.33  Indicator of field ordering and display width (top line)

After you have finalized the choice of fields and their sequence in the output row:

Specify the sort order for one or more fields

• Click on Sort just below List (Fig. 2.33).

If you wish to sort by Section and have the Names appear in alphabetical order within each
section:

• Click on Section.

• Click on Name.

Note: By Name is the default so the last step really isn’t necessary in this instance. If you sort
by 2 fields, you are actually sorting by 3 since By Name is always defaulted.

Normally, you select the sort fields from among those you included in the listing. To change
your selection of fields, click on the field a second time. You can also change the ordering of
the selected fields by dragging.

• Click OK when you are ready to perform the sort (Fig. 2.34) or click Cancel to abort.



Fig 2.34  Sorted list window

Note: Use the Windows menu to view the various windows. If a portion of the Student
window is visible, you can also switch windows by clicking within the window you wish to
bring to the foreground.

Calculate class rank

In addition to the use of a sorted listing of grades, you can produce class ranks—an
additional piece of information which is often of interest to students.

• Pull-down the Special menu with the mouse and drag to Rank...  before you release the
mouse button.



Fig 2.35  Select class rank field and results field

The top line of the screen indicates your current choices. Let’s find the class rank for HW 2
and place the rankings in the Rank field (Fig. 2.35).

• Click on HW 2.

The Rank field has already been selected by default, as indicated by the top line, by the bold
outline of the field, and by the cursor which changes to an arrow when placed over the field.

Note: If you have created more than Rank field (as in Fig 2.6), use the cursor to identify the
storage field.

Fig 2.36  Select calculated rank field

• Click OK.

MacRegistrar sorts the scores in HW 2, calculates ranks, and stores them in the designated
field. You can select class rank as one of the fields for sorting. You can create additional Rank
fields and save other ranks. On the other hand, you can overwrite the existing rank field
with subsequent rankings.



A graphical view of the data is often useful, as are the descriptive statistics—mean and
standard deviation.

• Pull-down the Special menu with the mouse and drag to Create Graph...   before you
release the mouse button. A screen similar to Fig. 2.35 appears.

• Select a field you want to plot in histogram form, e.g, HW 1.

• Click OK.

Fig 2.37  Graph options

• Accept the Histogram default by clicking OK.

If you also select one of the student information categories such as Class, College, Lecture,
Lab, or Section, then the histogram type selection (Stacked or Side by Side) is relevant.

Suppose you wish to compare the performance on HW 1 of the freshmen and the seniors in
the class.

• Click on HW 1.

• Click on Cl.

• Click on OK.



Fig 2.38  Select histogram comparisons

The Choose window with a scroll bar appears at the right of the Graph Options window.

Fig 2.39  Select class comparisons

• Click on 1.

• Command-click on 4.

• Click OK.

Note: Click to select a single entry. Command-click allows you to select any arbitrary, i.e.,
disjoint, combination of items; shift-click allows you to select a contiguous range. You can
place up to six (6) subclassifications on a single histogram.

Note: If you select more than six, the first six are used; if you select none, then the first in the
listing is used.



Fig 2.40  Histogram for freshmen and senior scores

You can use Graph Options to change the form of the plot.

You can compare scores assigned by different paper graders.

Descriptive statistics are also available if you click on the icon at the bottom right corner of
the histogram (Fig. 2.40).



Fig 2.41  Descriptive statistics for Fig 2.40 histogram

Term grades

Eventually you will assign a single figure of merit to characterize the student’s term
performance.

Two fields have been reserved at the right of the Student screen (Fig 2.1) for the Course
Average and for the Course Grade. In order to compute these values, you may need some
additional commands. For example:

Format grade fields
Format the average field
Format the final grade field
Drops of lowest grades
Set data ranges for individual grade fields
Select weighting scheme for combining grades
Matching numerical ranges with letter grades.

This last operation can involve a highly individualized process which often is not described
explicitly or publicly. MacRegistrar supports a very flexible process.

Format fields

• Select a field, e.g., Quiz 4 (Fig. 2.4)



• Pull-down the Scores menu (Fig. 2.42) with the mouse and drag the cursor to Format...
before you release the mouse button.

Fig 2.42  Format commands

You can also use command-M .  A window for the specification of the field format appears
(Fig. 2.43).

Fig 2.43  Select score format

Entries can be numbers or letters. In the case of Quiz 4, note that the field is an integer field
having a range of 0 to 27. You need not record individual entries as a decimal fraction.

If you have already stored scores in the field you just selected, any change in the format can
result in incompatibility. Therefore, the program asks whether it should convert (according
to the relationship described in Letter Grades... of Scores) or erase the data, or whether it
should abandon the proposed change (Fig. 2.44). The changes may be irreversible; therefore,
think before you proceed.



Fig 2.44  Conversion of existing score

2. Average Format  (Fig 2.42)

You must format the field reserved to receive the weighted average result. Since the
Average field is permanently designated, you need not select a field before you select this
command.

• Pull-down the Scores menu with the mouse and drag to Average Format... before
releasing the mouse button.

Fig 2.45  Format the weighted average field

The average field must be numerical and is usually decimal. If you have used letter grades
during the term, you will probably set the range as 0.0 to 4.3, where 4.3 corresponds to an A+.
If you have used numerical scores, you will probably set the range as 0.0 to 100.0.

3. Grade Format... (Fig 2.42)

The final course Grade also has a reserved field which you must format. Suppose you intend
to report a letter grade. Then,

• Click Letter and indicate whether only A-F or only S/U.



If “L” appears in the GrOpt field in the student information section of the screen and you
have selected Letter grades, MacRegistrar uses the S/U option for that record, over-riding the
general designation.

Fig 2.46  Assign final course grade format
4. Drop Lowest...(Fig 2.42)

• Pull-down the Scores menu with the mouse and drag to Drop Lowest... before you release
the mouse button.

Fig 2.47  Selection of grades to be included

This option allows you to exclude certain scores from the weighted average calculation.
Dropping the lowest score in a given category is probably the most common such
adjustment. You can apply this condition to any of the categories. Perhaps more useful in
the generalized environment of MacRegistrar is the Keep best grades option. Let’s accept the
default of dropping no scores.

• Click OK to accept your choices.



Let’s turn our attention to finding a composite score for the course.
Fig 2.48  Assign weights, calculate course average, etc.

5. Weights...(Fig 2.48)

• Pull-down the Special menu with the mouse and drag to Weights... before you release the
mouse button.

Fig 2.49  Weights window



We have implemented two different weighting schemes. The traditional scheme assigns
percentages of the average score derived from each category, i.e., column. Let’s review the
first and defer the second to the Reference chapter. The details of the algorithm are also
presented in the Reference chapter.

If not already selected:

• Click on the six capital sigmas at the top right of the screen to enable this option.

• Assign weights to each column by dragging the white circular dots at the top of the screen.

The percentage allocation always appears at the top of the screen and readjusts as you drag
the control points. They always total 100%. The arrow heads at the top left permit you to
initialize the control points at either end before you begin making assignments.

• Click the right most of the two arrow heads.

Now assign the weights:

HW 10% ; Quiz 20%; Lab 0% ; Project 0%; Prelim 40%; Final 30%

Fig 2.50  Assign weights for each column

• Click OK

6.  Calculate Average...(Fig 2.48)



• Pull-down the Special menu with the mouse and drag to Calc. Average... before you
release the mouse button.

Fig 2.51  Select averaging technique

Again, at this step several options are available. Let’s use the defaults, Weighted Average
and no credit for missing scores.

If you use the last option MacRegistrar assigns a zero  course average for any student records
that do not have scores for all of the expected fields or, for whatever reason, cannot be
computed. The program ignores a column having zero weight. See the Reference chapter for
a discussion of the other options.

• Click OK to initialize the calculation.

7. Calc. Grade...(Fig 2.48)

• Pull-down the Special menu (Fig 2.48) with the mouse and drag to Calc. Grade... before you
release the mouse button.



Fig 2.52  Letter grade assignment window

The initialized screen presents a class list ordered by weighted average. The grade division
markers are initially at the top left of the screen; at the right of the screen are the grades,
number of students currently assigned to each grade range (n), the percentage of the class in
that range (%), the cumulative percentage of the students in and above the current range
(∑), and the numerical range currently associated with each letter grade.

For small classes this serves as a convenient starting point. For classes of approximately
thirty or more, a uniform distribution may serve as a more convenient starting point.

• Click the leftmost of the three reset icons at the bottom of the screen.
Fig 2.53  Uniform distribution reset icon

The following initial distribution results.



Fig 2.54  Uniform initial distribution

To assign grade ranges:

• Drag the A+ division line (the topmost line) to the lower end of the A+ range, e.g., after
Wishart.



Fig 2.55  Adjust lower limit for A+

The next score below the cutoff for the A range (79.9) is quite close. A review of the details of
the Jones record might influence the choice of the cutoff.

• Double-click on Jones, F to retrieve that record.
Fig 2.56  Double-click to review the details of a record



Fig 2.57  Student record review

Click OK when you wish to return to the grade assignment window.

Due to some extenuating circumstances, e.g., a two-week medical leave which resulted in an
abnormally low grade, you may wish to move the Jones   grade higher.

• Drag Jones   to the space between Irish  and Aneshansley.
Fig 2.58  The ordered list can be altered by dragging

The program now readjusts the list order and   grade assignment as follows:



Fig 2.59  The revised partial list

Manipulate the list until you are satisfied.

Output to Printer and to Files.

So far in this demo all output has been routed to the screen. We have implemented two
other possibilities — output to a printer and output to a file. You will find a printer
invaluable for producing archival records, for preserving a backup, for analysis of trends, for
producing communications to the students, as well as for the important verification of your
input.

Prepare the printer.

Verify that your printer is properly prepared before you advance to the following section. If
you are using a LaserWriter, use the Control Panel of the Apple menu to verify that
AppleTalk is connected. Then use Chooser, also on the Apple menu, to properly route the
output to the LaserWriter or ImageWriter printer.

1. Print Individual Student Records.

•Activate the Student window (Windows menu) if not already active.

• Pull-down the File menu (Fig 2.3) with the mouse and drag to Print Student Records...
before you release the mouse button.



Figure 2.60  Output menu

• Select Final or Draft quality if you are using an ImageWriter.

• Specify the range of records you want to print:
The currently displayed record
All students
All students in a selected group
Selected students.

If one of the subdivisions (TA, Class, College, Lecture, Lab, or Section) in the View menu has
a dot preceding it, then MacRegistrar enables the All students in a selected group option, and
the subdivision selected by the Arrow scroll becomes available for printing.
If you choose the Selected students option, you can select any combination of records you
want to print. As with the Select option of the Record menu, you can either:

◊ identify a single record by typing part of the name and pressing return or by scrolling the
desired name into view and clicking on it

◊ select a contiguous group of names using the technique above to select the first name in
the list, scroll until the last name in the desired group is visible, and then shift-click on it
to designate the entire range

◊ select a discontinuous group using the technique above to choose the first name, scroll
until the next desired name is visible, and then command-click to add it to the
developing list

• Click OK when your selections are complete.



Except for specifying the placement of page breaks and the font and font size, MacRegistrar
automatically formats the records for you.

• Click on Fonts  to select the font and font size for the output.

Note: The font sizes in the system file appear in the middle column. MacRegistrar generates
other sizes when you enter them in the third column box.

Fig 2.61  Font and font size selection

• Click OK to return to the print window.

Finally, you can now send the record(s) to the printer or to a PICT file.

Either:

• Click Printer  or  Click File.

MacRegistrar automatically names the file which you can edit and print using MacDraw.

Note: Because MacDraw allows a limited number of fonts in a PICT file, we have also
attached a PICT resource to the file which you can retrieve with a resource editor (ID=128).

2. Print Sorted Lists.

If you have selected a sorted list in the Windows menu and prepared it as described earlier
(Fig 2.32), you can send that sorted output to the printer or to a file. Create a sorted list now,
if one is not already available, and then:

• Pull-down the File menu with the mouse and drag to Print Sorted List... before you release
the mouse button.



Fig 2.62  Modified File menu

Note that the name of this menu item has changed to reflect its current usage.

Fig 2.63  Print/file sorted lists

Describe the output you wish to print now.

As before, you can specify the print quality if you are using an ImageWriter. You can also

specify the range and add automatic page numbers.



• Click on the Page Numbers box.

You can add a header to each page.

• Click on the Header box and supply a header.

The header can be left, center, or right justified and can be printed on just the first page or on
the top of every page.

• Select page breaks after every 10 lines.

If you had sorted by section, you could add page breaks between sections.

You can change the font or font size.

• Click on Fonts  and make your choices.

• Click OK to return to the Print menu.

Finally, if you wish to maintain a left binding margin, e.g., for a 3 ring binder, assign a left
margin. If you need multiple pages per line, a message appears on the screen.

You can either:

• Click Printer or Click File.

Note: If the required output width exceeds a standard page (e.g., choice of many fields or a
larger font size), the program automatically produces a multiple page width to preserve the
requested information. It labels the leftmost page A and the next group of columns page B,
etc. The top of the screen indicates the layout. If you need multiple pages per line, you can
elect to have Name, CUID, or both repeated on each page.

Note: This option also allows you to produce an archival copy of your records which you can
use in future years, even if you use a different computer.

Export/Import (Fig 2.62)

Many users may not need the Export/Import capability; therefore, this section may be
optional reading.

1. To the Registrar.

The most common operation is the export of the term results to the Registrar via diskette
(or telecommunication). We assume that you have already computed the term Grade field,
have made any necessary manual adjustments to the automatic conversion, and have
printed a copy.

• Pull-down the File menu (Fig 2.62) with the mouse and drag toExport...  before you release
the mouse button.



Fig 2.64  Export choices

The Export menu allows you to choose or create an export format and to name the Export
file. We will examine and then use both defaults.

We could just accept both defaults by clicking on Export; however, examine the procedures
briefly.

• Click on the Format button.

Fig 2.65  Select, edit, or create export format

At this point let’s examine the Standard Export to Registrar file.

• Click on Edit.



Fig 2.66  Edit export format

Let's examine, but not change, the contents of this movable window. You can edit the title of
the format name. MacRegistrar can produce fixed width and variable width fields. The
database fields appear in the scrollable window and show the widths in braces. The Include
course information box has been checked.

• Click Cancel to abort the edit process.

With the Standard Export to Registrar title highlighted:

• Click on Select.

You have now returned to the original export window (Fig 2.64). Let’s accept the default
name for the export file.

• Click on Export.

MacRegistrar has created a text file. You can use any word processor which reads a standard
ASCII text file to review this file. Do not tamper with the spacing in the file. Follow
reasonable security precautions to assure the integrity of this file.

Export to Excel, DataDesk, Cricket Graph or to a Pascal or FORTRAN program and then
Import the data after modification by one of these programs.



Suppose we wish to export the six homework grades for study in another program.

• Pull-down the File menu with the mouse and drag to Export... before you release the
mouse button.

The window of Fig 2.64 appears.

We must create an export format, therefore:

• Click on Format.

The Select Export Format window appears.

Fig 2.67  Select, edit or create the export format

• Click on New.

A default name appears. Edit this name if you wish. In this file we wish to have variable
length fields separated by horizontal tabs (ASCII HT). The default delimiter is the desired
character but examine the assignment procedure anyway.

• Click on the hollow rectangle to the right of the ASCII code box.

A table of the ASCII set appears.



Fig 2.68  Select field delimiter

• Click on a character to select it, HT in this case.

The ASCII window closed automatically.

The remaining two check boxes allow you to include format headers and course
information (Instructor, Course Name, Section, etc.) at the beginning of the file. Let’s omit
these pieces of information.

Next you must select the fields you wish to include in the export file. If the Export Format
window obscures some of the fields of interest, drag it to a different location.

Note: You MUST include either the student Name or CUID in the export file if you intend
to subsequently import some of the file. Also, you must have put at least the Name field in
an export format to activate the OK button.

• Click on each field in the desired ordering for the file.

Name

HW 1
HW 2
HW 3
HW 4
HW 5
HW 6

The list appears in the scroll menu.

Note: To remove any field from the list, select its name and click the minus icon. The icon
with the up arrow allows you to add field names before a currently selected field. The icon
with the down arrow allows you to add field names after a currently selected field.



• Click OK.

This creates a format with the default name. Next you must choose this format:

• Click on Select to accept this format.

• Assign a file name for the export file.

• Click Export.

Fig 2.69  Export status report

The student window becomes active again when you have completed the data export.

Note you may wish to use a word processor, e.g., MacWrite or Word 3.0 to examine the
export text file. For WriteNow, use the Translate program first.

This export file can be read directly by Excel without any special preparation. We leave that
as an exercise for you.

Import.

In preparation for the next exercise destroy the contents of the homework fields so that
when MacRegistrar has completed the import, you can be satisfied that you have mastered
the process.

• Assign 0 to HW 1 of the current student record.
• Pull-down the File menu with the mouse and drag to Fill  before you release the mouse

button.

This sets HW 1 to zero on every record in the course file.

With the field still selected:

• Pull-down the Edit menu with the mouse and drag to Copy All  before you release the
mouse button.

This makes a copy of this field on every record.

• Select in turn each of the remaining HW fields.

• Pull-down the Edit menu with the mouse and drag to Paste All  before you release the
mouse button.



MacRegistrar has now erased all homework information. You can begin the import process.

• Pull-down the File menu with the mouse and drag to Import...  before you release the
mouse button.

Fig 2.70  Import options

Data import has three basic categories:

◊ Create/Append Course
◊ Drop/Add Students
◊ Import Grades

Create/Append imports the student data included at the top of the student screen. No grade
information is included. This is the form of the data file received from the Registrar before
the term begins. Drop/Add Students updates data in your course files using the Registrar-
supplied update file. Import Grades is applicable in the present exercise; we wish to restore
the data exported in the previous exercise.

• Click on Import Grades to select the option.

• Click on Format to select an import format.



Fig 2.71  Select import format

• Click on New to customize a format.

MacRegistrar assigns a default name; modify it if you wish. Since the export field delimiter
was the ASCII 9 character, choose that here. Also since MacRegistrar did not export the
course information and format header, they should not be checked here.

• Select the same fields in the same order you selected them in the export exercise.

• Click OK.

When the Select Import Format window returns:

• Click on Select.

The final step is to select the data file used to store the exported data.

• Click on the name of the format you just created.

• Click on Import .

The import notice provides a progress report on the number of records imported so far.

Miscellaneous Operations.

The Special menu has three additional operations:

◊ Change Password...
◊ Change Course Info...
◊ Generate IDs.
• Pull-down the Special menu with the mouse and drag to Change Password...  before you
release the mouse button.



Fig 2.72  Assign a course file password

You can enter a secret password to thwart casual inspection of your course files, but you
MUST remember the password if you wish to use the files again. The best protection, of
course, is to secure physically your floppy or hard disk files. Your password should be an
easily remembered code, but not one which will be obvious to an intruder.

• Pull-down the Special menu with the mouse and drag to Change Course Info...  before you
release the mouse button.

Fig 2.73  Course information

Edit any of the fields you wish to change.

Note: If MacRegistrar imported the class list from the Registrar as a text file, the college,
department, and course number codes will appear to the right of the corresponding text
fields. The text fields may contain useful alphanumeric information, but MacRegistrar uses
the corresponding numerical codes imported with the Registrar's file during export to the

Registrar. Therefore, you cannot edit these codes within the program. If you entered the class
list, MacRegistrar requests these identifying codes during the export process.



• Click OK.

• Pull down the Edit menu with the mouse and drag to Generate IDs  before you release the
mouse button.

Fig 2.74  Generate internal identification numbers

Normally, you perform this operation just before you intend to post the first set of
confidential scores. You can generate nonrepeated IDs later for new additions to the class
without destroying the original set of numbers.

• Click OK to accept the default generation process and maintain any existing numbers in
the IntID field.

Closure.

This completes the guided tour of MacRegistrar features. Refer to the following chapters if
you require a more detailed review of the features.

To complete this exercise:

• Pull-down the File menu with the mouse and drag to Close Course before you release the
mouse button.

• Pull-down the File menu with the mouse and drag to Quit  before you release the mouse
button.

To terminate the session:

• Pull-down the Special menu of the Finder with the mouse and drag to Shut Down  before
you release the mouse button.

The disk ejects and the system powers down. Develop the habit of securely storing your
program and data disks.

Do that now.



Chapter 3     Advanced Techniques

In the preceding chapter you used an existing course file to examine the most frequently
used features of MacRegistrar. This chapter includes several important but less frequently
used techniques. You will learn to transfer a class list text file supplied by the University
Registrar into MR to create a course file and to transfer the course file from MR into a text
file and then into general tools such as Excel, Cricket Graph, and DataDesk. You will also
learn to update your class list at the end of the drop/add period and to export final grades to
the Registrar at the end of the term.

In the final section the versatile grading algorithm built into MR is detailed. For the
ultimate level of flexibility and generality, we have included an outline of a Pascal program
to compute a weighted average as a shell for you to customize.

3.1 Import Class List From Registrar

To create course files manually, use the New  command of the Record menu, then keyboard
entry. However, MR offers a significantly more convenient process for larger courses. In this
section we assume that your class list is a machine readable text file. Now, let's transform
such a text file into the specialized, compressed format used by MacRegistrar.

Suppose your class list is in a fixed field width format as follows:

Cooke, J. Robert
02
02
100
Albright, G               307446 058784598 1 02 01 01 01 0200 L
Aneshansley, I            310066 907645354 1 03 02 02 02 0200 E
Bart, B                   311957 564654565 2 04 03 04 04 0200 L
Bartsch, E                301814 864654521 3 02 01 06 06 0200 L
Bates, W                  284216 986565624 1 01 02 03 03 0200 L
    (more)
Fig 3.1  Registrar import file displayed with variable width characters

Only a few records of the text file AGEN100.F87 supplied on the distribution disk appear
above. When you load this file into your word processor, the fixed width fields appear to be
improperly aligned. Select the entire document and change from the variable character
width Geneva font to a monospaced font such as Monaco or Courier. Then the alignment of
the fixed width columns becomes apparent.

Cooke, J. Robert
02
02
100
Albright, G               307446 058784598 1 02 01 01 01 0200 L
Aneshansley, I            310066 907645354 1 03 02 02 02 0200 E
Bart, B                   311957 564654565 2 04 03 04 04 0200 L
Bartsch, E                301814 864654521 3 02 01 06 06 0200 L
Bates, W                  284216 986565624 1 01 02 03 03 0200 L
    (more)
Fig 3.2  Registrar import file displayed with fixed width characters



The first four lines give the instructor name, a two digit college code, a two digit department
code, and a three digit course number. Collectively these are referred to as the "Course
Information" fields. When establishing the import file format below, you must select
"Include Course Information" (Fig 3.9). The remainder of the file consists of student records.
In this example the data for each student enrolled in the course is a record consisting of ten
fixed-width fields, each   separated by a space. Fig 3.3 gives the field sizes.

   Field      Length      Description   
Name 25 Last name, comma, first name
CUID 6 Student's identification number
SSN 9 Social Security Number
Class code 1 Student's class number
College code 2 Student's College number
Lecture code 2 Lecture code number
Lab code 2 Laboratory code number
Section code 2 Section code number
Credits 4 Number of credits*
Grade option code 1 Letter or S/U**
* In this example 0200 designates 02.00 credits with the decimal omitted.
** L= letter grade, E= S/U exclusively, O=optional (becomes L or E)

Fig 3.3  Format of Registrar Import File (AGEN100.F87)

Note: Narrow settings of the left and right margin can produce line wrap.

Import the example data file AGEN100.F87.

With the MR disk in the drive,

• Double-click the MR icon.

Fig  3.4

You need not use New Course...  to create a new course file because the required
information will be obtained from the AGEN100.F87 file.

• Choose Import... from the File menu.



Fig 3.5  File menu

The Import window (Fig 3.6) appears. Since you wish to create a course file, you can use the
default choice (Create/Append Course). This option adds new records to the end of a course
file; in this instance no previous records are in the file.

Note: The second and third options are discussed in subsequent examples.

Fig 3.6  Import Window

The Format defaults to Standard Import from Registrar and corresponds to the format of the
data file in Figure 3.2.



Fig 3.7  Format button

• Click on the Format button to review the format.

Fig 3.8  Select Import Format window

From this menu you can create a new format, edit an existing format, or delete a format. In
this instance, just examine the existing format which already corresponds to the format of
the file AGEN100.F87.

• Click on Edit.



Fig 3.9  Import format window

The background screen shows the student record template. The movable Import Format
window is superimposed on the template. The format name appears in the first field. Make
no changes now, but note that the name could be edited.

Fixed width field input is the default. In other words, each field of input data must have the
specified number of characters. [“Delimited by ASCII code” allows variable length fields and
is described in the export example which follows.] The Include Course Information box has
been selected; this sets the format to include the first four lines of the AGEN100.F87 file. The
Include Format Header is not required here and is discussed later in this chapter.

• Scroll the window to review the file format.

Make no changes to the format now, just note that you can add fields before or after a
selected entry, and you can delete them. To add a field to the list, simply click in that field of
the student record template; if a desired field is not visible, move the Import Format
window by dragging the title bar.

• Click OK when you are ready to return to the Select Import Format window.

Note: Any formats you define are saved as part of the MacRegistrar application for later use.
Consequently, the MR application must not   be locked.

The Select Import Format window (Fig 3.8) returns to view and you must now choose a
format. The just-examined format is the default; therefore, you need only:



• Click Select.

MR now returns you to the Import window (Fig 3.6). The final step to initiate data
importing is the selection of the data file. Use the customary techniques to select the drive,
folder, and specific data file. In this example select the sample file AGEN100.F87.

• Click Import .

The importing process can be lengthy as a result of the data checking process we included.
The Importing...  window indicates progress.

Fig 3.10  Importing status window

If necessary, you can interrupt the data transfer process and then either resume or abort the
process.

If the data file does not conform exactly  to the import format, the process aborts
automatically. Use the Show Markers, Show Space, or similar options in your word
processor to check conformity of the file. Extra characters cause a format mismatch. We
recommend that you use your word processor to verfiy that MR read all records.

Note: To use WriteNow you must first translate the data file into text format using the
Translator and then open the file by WriteNow. To return to text format, use the Translator
again. Word 3.0 reads text files directly; for output you must use Save As... and select the
Text file output option. Word 3.0 has convenient pre-set tabs. MacWrite also reads a text file;
select the first option (carriage return for end of paragraph). Save your modified file in text
format.

When the import process terminates normally, MR automatically opens the course file just
loaded; and the file is ready for use. You must supply the TA (teaching assistant, paper
grader, etc.) name. As you scroll through the file making this addition, the cursor
automatically retains correct placement in the TA field. MR automatically fills the IntId field
using the Generate ID's... command in the Special menu. The internal identification
numbers are course specific and can be used to post test scores without violating the
student's right to confidentiality. If you subsequently add additional students to the class list,
you can preserve any previously generated and used IntId numbers.



3.2  Export of Data

MR is open ended, allowing you to transfer data back and forth between MR and other
applications. For example, if our course grade calculation scheme does not encompass your
favorite algorithm, simply export the data as a text file, perform the calculation using
another application or even one you have written, save the results (including the student
name or CUID) in a text file, and import the results. An outline of such a Pascal program is
included in section 3.8.

In this section we outline the first of these steps—exporting data.

Let's use Intro to Agr Engr, the sample course file distributed with MR, and export the
student name and the six homework scores.

• Use Open Course... in the File menu to access Intro To Agr Engr.

Fig 3.11  Export command

• Select Export... for the File Menu.



Fig 3.12  The Export window

The default options for the Export window have been set to export the term results to the
Registrar. We will return to this window later; however, at the moment we want to export
the homework scores.

• Click the Format button.

The Select Export Format window appears.

Fig 3.13  The Select Export Format Window

• Click New to define the export format.



Fig 3.14  The Export Format Window

• Assign a name to the format you are creating, e.g., Export Format 1.

• Click Delimited by ASCII code.

This means that field will be separated by the ASCII character specified. If you forget the
ASCII codes, click on the character enclosed in apostrophes.



Fig 3.15  Select Delimiter Window

• Click on HT  for the horizontal tab character, used by many applications such as Excel,
Cricket Graph, and DataDesk.

MR then returns you to the previous window.

• Leave Include course info and Include format header in file unchecked  (Fig 3.14).

• Select the desired fields by clicking (Fig 3.14).

Note: You must include student name or CUID if you wish to subsequently import the data
or some derived values.



Fig 3.16 Format Window again

• Click OK.

The just created format is the default now.

• Click Select (Fig 3.17).

Fig 3.17  Select Export Format window again

Finally, name the text file that will receive the exported data.



Fig 3.18  Export Window again

• Name the file HW.DAT and click Export.

MR now transfers the data into a text file HW.DAT.

 Fig 3.19  Data export status window

You have just created a text file named HW.DAT which can be read by your word processor
as well as by other applications. You may need to set tab stops to obtain one-student-record-
per-line formatting. As established in the export format, a tab character separates each
column (field) and a carriage return separates each row (record) .

Note: To use WriteNow, you must first use the Translator to convert from text to the
WriteNow file structure.



Albright, G 67 67 65 65 54 87
Aneshansley, I 77 86 71 71 83 93
Bart, B 61 51 98 98 76 57
Bartsch, E 95 55 100 100 78 63
Bates, W 64 95 80 80 66 72
Becker, T 84 78 92 92 58 98
Boss, F 52 69 90 90 56 76
Brown, X 59 50 82 82 71 68
Burns, A 65 71 59 59 52 97
      (and more)

Fig 3.20  Text file contents

We will use this file in subsequent exercises.

3.3  Import Data Into Excel

If you have not created the text file HW.DAT in section 3.2, return to that section now to
prepare the file for Excel.

Fig 3.21  Excel icon

• Double click on the Excel icon to open a worksheet.



Fig 3.22  Excel Worksheet

• Open the data file HW.DAT.

Fig 3.23  Open the text file

• Select the folder containing the file.



• Select the text data file HW.DAT.

Fig 3.24  Select the text file

MR stores the data in rows and columns. You can resize the columns as desired. With
narrower columns you can see all six data columns.

Fig 3.25 Worksheet with HW data.

A spreadsheet program is especially useful in carrying out specialized computations for
weighted average. Let's use column H to sum the homework scores for each student.



Fig 3.26  Worksheet with sum of homework scores in column H

3.4  Import Data Into Data Desk

You can use Data Desk to examine the data in considerable detail; however, we will
demonstrate the import process and create a simple plot. Like the authors of Excel, we will
omit many useful features here in the interest of simplicity.

Fig 3.27  The Data Desk icon

Let's use the HW.DAT text file created in section 3.2. Each row of data is separated by a
carriage return, and each column is separated by a tab character. This structure is
immediately apparent if you read the text file with Word 3.0.

• Use Read Text file... of the File menu to access the data file HW.DAT.
Note: The course file AGEN100.F87 from the Registrar does not have the expected format
(e.g., tab delimited) and cannot be read correctly.
According to the Macintosh convention, select the objects before giving the command:



• Select the data you want to plot.

Fig 3.28  Choose variables to be plotted

• Choose the Scatter Plot command of the Display menu.

Fig 3.29  A Data Desk Plot (of different variables)

With a statistics program such as this you can identify students whose performance has
changed during the semester.

3.5  Import Data to Cricket Graph

Fig 3.30  Cricket Graph icon



• Double click on the Cricket Graph icon.

Fig 3.31  File menu

• Open the data file.

Note: The “Show all TEXT files” box must be checked (Fig 3.32).

Fig 3.32  Select file

Load the data as shown below.



Fig 3.33  Data loaded in Cricket Graph

You can label the columns and produce a graph such as the following.

Fig 3.34 A Cricket Graph plot



Clearly there is no correlation between scores on the first and second homeworks. A plot
such as this allows you to identify students whose scores on HW2 were better or worse than
on HW1. Scores on a straight line with a slope of one and passing through zero correspond
to identical performance on both HW1 and HW2.

3.6  Drop/Add Students

You can drop or add student records to the course list at any time using the Delete  and New
command of the Record menu. We have provided a more convenient import technique for
massive updates.

If you have not yet added data to your existing course file, simply retire the old file and start
anew using the technique of the previous section. If you have added grades, you can export
the data from the old course file, create a new course file using the updated class list, and
then import the grades. A better approach is to update just the Registrar portion of your
course file.

Suppose the Registrar has provided you with a text file of all current students (not just the
records being changed) in the same format as the original Registrar file.

Cooke, J. Robert
02
02
100
Albright, H               307446 058784598 1 02 01 01 01 0200 L
Aneshansley, I            310067 907645354 1 03 02 02 02 0200 E
Bart, B                   311957 564654566 2 04 03 04 04 0200 L
Bartsch, E                301814 864654521 4 02 01 06 06 0200 L
Bates, W                  284216 986565624 1 02 02 03 03 0200 L
Becker, T                 311675 221245589 1 04 08 05 05 0200 L
Boss, F                   309343 025874139 1 02 04 03 02 0200 L
Brown, X                  276562 145065583 1 02 05 01 02 0200 L
Burns, A                  307987 873233373 1 02 04 06 06 0300 L
Campbell, I               276923 456456423 4 01 02 03 03 0200 E
Student, A                333333 444444444 4 04 04 04 04 0400 E
Cook, H                   290995 036678381 1 01 04 02 02 0200 L
Cook, S                   297378 345687508 3 02 02 01 01 0200 L
....(more)....
Wishart, O                387897 455666490 3 02 01 06 06 0000 O

Fig 3.35  Portion of an update text file (AGEN100.F87Update)

• Make a duplicate of your existing course file on a separate disk so you can recover from a
gross blunder.

• Load the existing course file in MR.

• Select Import... from the File menu.

• If not already done so, choose the Standard Import from Registrar format and verify the
choice of fields using the Edit button.



• Select the import file, e.g., AGEN100.F87Update, and click Import .

Note: The MR does not alter the TA and IntId fields.  If you wish to preserve any other fields
e.g., section, you must remove that field from the format and replace it with the appropriate
number of blanks.

For this demo file, we modified each of the first 10 records. The first record has a modified
name; the second, a changed CUID; the third, a different SSN, etc.  We deleted the Caveney
record and added Student. When a record contains a CUID, MR matches the record on the
basis of CUID and the first 3 letters of the last name. If the records do not contain a CUID,
MR matches on the basis of the student name.

If a record has a modified name, but the same CUID, MR replaces the old record with the
modofied record and archives the old record. MR also archives records that are not included
in the update file.

• Use Archives... on the Record menu to update the course file with the revised list.

Note: The program does not check for duplicate CUIDs in the update file. Use the Database...
command on the File menu to verify that duplicates do not exist in the course file.

3.7  Import Grades

MR allows you to import a text file of grades.  The import file need not contain data for
every student, but must have the student names or CUIDs which exactly match the record in
the course file. You can create an ASCII character delimited export file of the names and
CUIDs with MR and enter the grades using a word processor, a spreadsheet program, or a
specialized program. The file can also originate with a machine scoring program.

• Load the course file.

• Click Import... on the File menu.

• Edit an existing file format or create a new format to correspond to the data in the text file
(See Fig 3.35).

• Select this format.

• Select the import file.

• Use Archives... of the Scores menu to check for records which did not match the name or
CUID of an existing record.

• Use Sort... on the Special menu to produce a verification list.



3.8  Weighted Average Calculations

Fig 3.36  Sample record

You can compute the weighted average for the above record as follows if all entries within
each column are weighted equally :

or

or

Wt_Ave = +0.10 
 
  
 67

100−0  
+ 

 67
100−0  

+ 
 65

100−0  
+ 

 73
100−0  

+ 
 54

100−0  
+ 

 87
100−0  


 
   6

+ 0.20 
 
  
 52

100−0  
+ 

 6.5
30−0  

+ 
 27.6

30−0  
+ 

 10
27−0  


 
   4

+ 0.40 
 
  
 70

100−0  

 
   1

+0.30 
 
  
 66

100−0  

 
   1

Wt_Ave = 0.10 [0.688]  + 0.20 [0.507] + 0.40 [0.70] +0.30 [0.66]
Wt_Ave = 64.8

See a more complete discussion in Calc. Ave... in Chapter 4.

Psuedo-code

The following psuedo-code outlines the weighting algorithms used.

PROCEDURE Calculate Average;

PROCEDURE Get Weighted Column Score;

BEGIN
WeightSum := 0; { Total of weights is initially 0 }
FOR each row in column DO
IF don't drop this score THEN
BEGIN
Grade := Retrieve grade from student;
IF grade exists THEN

BEGIN



Weight := Get weight for this grade;
WeightSum := WeightSum + Weight;{add weight to total wt}
IF LetterGrade THEN

Convert Letter to Number in Range 0 - 100;
IF Using Z-Score THEN

Grade := (Grade - Mean) / StdDev;
ColGrade := ColGrade + Grade * Weight

END
END; { for }

IF WeightSum = 0 THEN
ColGrade := 0

ELSE
ColGrade := ColGrade / WeightSum

END; { Get Weighted Column Score }

PROCEDURE Get Column Score By Points;

BEGIN
NGrades := 0; { Number of grades found is initially 0 }
FOR each row in column DO
IF don't drop this score THEN
BEGIN
Grade := Retrieve grade from student;
IF grade exists THEN

BEGIN
NGrades := NGrades + 1;
IF Number Grade THEN

PointSum := FormatHigh - FormatLow;
ELSE IF A to F Letter Grade THEN

{Letter grades are stored as integers from 1 to 13}
{Convert Letter to Number}
PointSum := 13  {FIX}

ELSE IF S/U with One Point value THEN
{ In this format, each S is worth one point and each U is 

worth 0 }
BEGIN

IF Just S or U THEN
PointSum := 1

ELSE { if SS, SU, US, UU }
PointSum := 2;

IF S, US, OR SU THEN Grade := 1
ELSE IF SS THEN Grade := 2
ELSE Grade := 0

END
ELSE { if S/U }

BEGIN
PointSum := 2;
IF U OR UU THEN

Grade := 0
ELSE

Grade := 1
END;

Grade := Grade / PointSum;
IF Using Z-Score THEN

Grade := (Grade - Mean) / StdDev;
ColGrade := ColGrade + Grade

END

END; { for }

IF NGrades = 0 THEN
ColGrade := 0

ELSE
ColGrade := 100 * ColGrade / NGrades

END; { Get Column Score By Points }

BEGIN { Calculate Average }



IF Using Z-Score THEN
GetStatistics;
FOR each student DO
BEGIN
Average := 0; { average is initially 0 }
FOR each score column DO

IF Column Percent <> 0 THEN
BEGIN

ColGrade := 0; { column grade is initially 0 }
IF scoring column by weights THEN

Get Weighted Column Score
ELSE Get Column Score By Points
Average := Average + ColGrade * ColumnPercent[Column]/100

END;
Store Average in Student Record

END { for }
END; { Calculate Average }

3.9  Export Term Grades to Registrar

You handle the export of the term results just as you did in 3.2 Export of Data. The export
format, as defined, includes only the information essential to a unique matching with the
Registrar’s database.

• Click Export... on File menu.

Fig 3.37  Export window

• Click on Format button.



Fig 3.38  Select export format

• Edit the output format.

• Click Select.

Fig 3.39  Edit format

The export format is university specific; therefore consult your Registrar for instructions.
• Click OK.

The same window (Fig 3.37) appears to enable you to name the export file.

• Click Export.



If you imported your course file from the Registrar at the beginning of the term, you need
not (cannot) supply the following information. If you typed you own records, you must
provide the following identifying information. Consult the Registrar for these details.

Fig 3.40  Course identification codes

Fig 3.41  More course identification

Fig 3.42  Term identifier

• Make a printed backup now using Sort... of the Special menu.

• This completes the export process.



Chapter 4  Reference Guide

This chapter provides a detailed discussion of each pull-down menu ( Fig. 4.1).

Fig 4.1  Pull-down menus



Let’s discuss each menu.

 Menu

Fig 4.2  Apple menu

4.1  About MacRegistrar™...

The copyright notice, license information, and authors are acknowledged here.

Fig 4.3  Copyright notice and credits

4.2  About Student...

The second entry, available only when a course is open, provides access to free-form text
notes about each student. Scroll to access the notes on each student. If you have added or
deleted records from the database, click Update to reconstruct the Notes list.



Fig 4.4  Text (e.g.,paper critiques, special circumstances) can be filed



File Menu

The File menu (Fig. 4.5) handles the interactions with the filing system (create a new course
file, open an existing course file, close the open course file, importing student records from a
text file into MacRegistrar, exporting records from MacRegistrar into a text file), perform
some maintenance/utility functions on the database, sending student records to the printer
and ending a session.

Fig 4.5  File menu

As is customary, the second menu provides access to the disk file system.

4.3  New Course...

Use New Course... to initiate a new course file. MacRegistrar then asks you to supply: a)
Course Name, i.e., the file name, and b) Disk

Next, complete the remaining items in the Course Information window (Fig 4.6)—
Instructor’s Name, Course College Code, Course Department Code, Course Number, and
free-form notes such as date, room, or other miscellaneous information.



Fig 4.6  Course information window

The Password window (4.7)  requests an optional password. If you elect to use a password,
MacRegistrar asks you to supply that information in order to access the database. Physical
security of the storage medium, however, is the preferred strategy.

Fig 4.7  Password window

4.4  Open Course...

Use Open Course...  to access any existing course file. The data files do not have to be on the
same disk as MacRegistrar. Only one course file may be open at a time; if necessary, use Close
Course  first.



4.5  Close Course

Use Close Course  to close a course file. MacRegistrar then updates the file indices and issues
an end-of-file marker. Since several windows can exist (Student, Field Info, Sorted List, and
Graph), clicking on a window close box does not close the course file. Only one course file
can be active at a time; therefore, you must close the open course file before you can open
another.

4.6  Save

Use Save frequently to assure a backup of your database in the event of catastrophic failure.
In the event of a power failure, you can recover your file just as it was constituted at the last
Save or when the file was opened, whichever event was most recent. MacRegistrar also
produces a backup file when you close the course file — unless you press the option   key
when you close the file. Your should make a backup just before you make global changes,
e.g., during import of data. ALWAYS maintain a backup of important data.

4.7  Import...

Use Import...  (of the File menu) to bring text file data into an open course file (Fig. 4.8).

Fig. 4.8 Import Dialog

◊ Select the type of import data:

1) add  student names and registration data to a new or existing course,
Create/Append Course

2) update existing student records of a course in progress (e.g., add or drop records, or
modify section ,credit and other information), Drop/Add Students



3) match records by name or identification number and then insert data into the
selected grade fields, Import Grades

◊ Identify the file (drive, folder, and name).

◊ Click Format to create or to select a different import format (Fig. 4.9).

Fig 4.9  Select, create, edit, or delete an import format

The program saves the format specifications as a MacRegistrar resource. If the desired format
already exists, you need only click on Select (Fig 4.9). Otherwise, click on New to create a
customized format or Edit to modify an existing format. Use Delete to remove unwanted
formats.

• Click Edit.

The Import Format window (Fig. 4.10) allows you to name the format and to specify field
type (either fixed width or variable width) and the field delimiter if you select a variable
width field. You can enter the field delimiter as a decimal ASCII number or select it from a
table that appears when you click on the symbol to the right of the ASCII code field.

Additional identifying information can precede the tabular data. Format header (Fig 4.11)
identifies the entries in each record, and course information identifies the course. See the
Appendix for a discussion of the format header.



Fig 4.10  Define an import format

%%edci070900130101130102130103130104130105130106%%
Cooke, J. Robert
02
02
100
Albright, G 67 52 * * 70 66
Aneshansley, I 77 99 * * 84 95
Bart, B 61 86 * * 77 64
Bartsch, E 95 83 * * 58 74
Bates, W 64 76 * * 94 68

Fig 4.11  Text file with one line header information,
four lines of course information, and five records

See the Appendix for a description of the header.

Fig 4.12  Add and delete icons



The three remaining icons allow you to delete the selected field or add fields before or after
the current field selection.

After you click OK, MacRegistrar returns you to the Select Import Format window with the
most recently edited format as the default. Click Select to choose the format and return to
the Import window.

Click Import  to initiate data transfer.

Fig 4.13  Import status

During a Create/Append operation duplicate names are counted in Matches (Fig 4.13).
During a Drop/Add operation names in the course file which are not in the update file will
be listed as Drops. During an Import Grades operation names in the import file which are
not found in the course file database are counted as Exceptions. Any of these records can be
retrieved or permanently deleted using Archives...  of the Record menu. If both names and
CUIDs are included in the course file and in the import file, records are matched by CUID
and the first three letters of the last name. If CUIDs are not included, only names are used to
establish the correspondence of records. Use the Database... command of the File menu to
verfiy that your database contains no duplicate names or CUIDs; this check is not made
automatically.

4.8  Export...

Use Export... (on the File menu) to send course data from your course file into a text file.

◊ Identify the file (drive, folder, and name).

◊ Click Format to create or to select a different export format.

The program saves the format specifications as a MacRegistrar resource. If the desired format
already exists and has been selected, you need only click on Export. Otherwise click on
Format.

Select a format, click New to create a customized format, or click Edit to modify an existing
format. Use Delete to remove unwanted formats.

• Click Edit.



The Export Format window allows you to name the format and to specify field type (either
fixed width or variable width) and field delimiter if you select a variable width field. You can
enter the field delimiter as a decimal ASCII number or select it from a table that appears
when you click on the symbol to the right of the ASCII code field.

Fig 4.14  Fixed width fields

In addition to the student information and course grade fields, course information fields
appear on the top row of the screen. A blank space is often useful.

Additional identifying information can precede the tabular data. Course identifies the
course, and the format header (Fig 4.11) identifies the entries in each record.

The three remaining icons allow you to delete the selected field or add fields before or after
the current field selection. Double clicking on a selected field name allows you to change the
field length.

After you click OK, MacRegistrar returns you to the Select Export Format window with the
most recently edited format as the default. Click Select to choose the format and return to
the Export window.

Click Export to initiate data transfer.

The import/export capability is a particulary important and powerful feature. You can export
data to a statistical application such as DataDesk™, to a spreadsheet such as Excel™, to a



graphical program such as Cricket Graph™, or to any other application which allows
standard ASCII text file input. You can, of course, also use the clipboard, to transfer
information. See Chapter 3 for illustrative examples.

4.9  Database...

The Database command on the File menu provides several utility functions (Fig. 4.15)

Fig 4.15  Database preferences

Preload data causes MacRegistrar to keep the maximum feasible amount of data and indices
in RAM for faster response.

Use Make backup to produce a duplicate copy of the database from within MacRegistrar
automatically when you close a file. Of course, you can make duplicate copies of the course
file and Notes file using Duplicate on the File menu.

Use Check Names & Ids to verify that your course file does not contain duplicate names or
duplicate CUIDs (Fig. 4.16).

Fig 4.16  Count the duplicate names and IDs



If duplicates are found, you may create a list of them (Fig. 4.17 and Fig. 4.18)

Fig 4.17  Show the duplicates

Fig 4.18  The list of duplicates

• Return to the Student window and remove the duplicate names and Ids.

• Purge the duplicate records noted in the Archives... window of the Record menu.



Fig 4.19  Archives list of Drops

4.10 Print Student Records...,
Print Sorted Lists... , and
Print Field Info

You can send output to the LaserWriter, ImageWriter, or a file by this command. Use
Chooser on the  menu to select the appropriate driver.

Use this command to print composite student records if the Student window is active.

If the ImageWriter driver is active, you could select Final or Draft quality output. In any case,
you can print a single record, all records, all records in a selected group (e.g., TA, Class,
College, Lecture, Lab, or Section, provided you select the category in the View menu), or any
combination of student records.

If you choose the latter, i.e., Selected students, you can:

◊ identify a single record by typing part of the name and pressing return  or by scrolling the
desired name into view and clicking on it

◊ select a contiguous group of names using the technique above to select the first name in
the list, scroll until the last name in the desired group is visible, and then shift-click on it
to designate the entire range

◊ select a discontinuous group using the technique above to choose the first name, scroll
until the next desired name is visible, and then command-click to add it to the
developing list



Fig 4.20  Specify student record output

• Click OK when your selections are complete.

Except for specifying the placement of page breaks and the font and font size, MacRegistrar
automatically formats the records for you.

• Click on Fonts  to select the font and font size for the output.

Note: The font sizes in the system file appear in the middle column. You can enter other
sizes in the third column box, and MacRegistrar will generate them.

At this point you can route the output to the printer or to a MacDraw PICT file.

Sorted List Output (one line per student).

If you use the ImageWriter, you can specify Final or Draft output quality, the print range,
and a page header on the first or on all pages. Page numbering is optional. Single or double
spacing is available. You can select line and page breaks. You can use any font in the system
file. If the line length exceeds the width of a single page, MacRegistrar automatically creates
additional pages and designates placement with an alphabetical suffix. Should you wish to
bind the output, you can assign the left margin. You can route the output to the printer or to
a MacDraw PICT file.



Fig 4.21  Specify sorted list output

4.11  Quit

By convention, the last item of the Edit menu is Quit. This command also closes the course
file and MacRegistrar.



Edit Menu

The Edit menu provides the usual editing commands and some global commands that affect
all records (Fig. 4.22)

Fig 4.22  Edit menu

4.12  Undo

You can undo most commands immediately after you execute them. Undo and Cancel
provide a measure of security against mistakes.

4.13  Cut

Cut removes highlighted material from its current location to the clipboard for subsequent
transfer to another location or application.

4.14 Copy

Copy transfers highlighted material to the clipboard for subsequent transfer to another
location or even to another application but does not remove it from its current location.

4.15 Paste

Paste transfers the contents of the clipboard to the location designated by the cursor. The
contents of the clipboard remain unchanged.

4.16  Clear

Clear deletes the contents of the currently selected field, leaving the contents undefined.



4.17  Cut All

Cut All copies the contents of the current field of ALL records to the clipboard and cuts the
values from all of the records.

4.18  Copy All

Copy All copies the contents of the current field of ALL records to the clipboard but leaves
the values from all of the records unchanged.

4.19  Paste All

Paste All transfers the contents of the clipboard created by a Cut All or Copy All command
into the respective records at the location designated by the cursor.

4.20  Clear All

Clear All deletes the contentents of the currently selected field on ALL records, leaving the
contents undefined.

4.21  Fill

Use Fill to assign the contents of the currently selected field to the corresponding field of
every record.

4.22  Auto Sort

Disable this option for faster record entry when you use the keyboard to enter data.



View Menu

Use the View menu (Fig. 4.23) to designate the category and order of records you see during a
scroll through the records.

Fig 4.23  View menu

4.23  by Name

You can use the student name (usually in “Last, First Middle” format) to index the files for
rapid access.  Use the same format, e.g., consistent use of commas, throughout to maintain
the proper sort order.

4.24  by CUID

You can use the CUID (student Identification Number), as well as student name, to index
the files for rapid access.  This number is used in addition to name to establish import
matches.

4.25  by TA

You can further restrict searches and scrolls by student name or identification number to
include only those records having a common teaching assistant. See 4.30 for additional
details.

4.26  by Class

You can further restrict searches and scrolls by student name or identification number to
include only those records belonging in a common class such as freshman, sophomore, etc.
See 4.29 for additional details.



4.27  by College

You can further restrict searches and scrolls by student name and identification number to
include only those records having a common college of enrollment. See 4.30 for additional
details.

4.28  by Lecture

You can further restrict searches and scrolls by student name or identification number to
include only those records having a common lecture number. See 4.30 for additional details.

4.29  by Lab

You can further restrict searches and scrolls by student name or identification number to
include only those records having a common lab assignment. See 4.30 for additional details.

4.30  by Section

You can restrict searches and scrolls by student name or identification number to include
only those records having a common section. When you have selected one of the six
subcategories, an additional scroll bar appears at the bottom corner of the screen (Fig. 4.24).

Click on the right or left arrow to select the next subcategory.

Fig 4.24  Subcategory and record scrolls

Click on the shaft of the arrow to obtain a list of all the subcategories; you can select any
subcategory directly from this list. Either click on a category and click Select or just double-
click on the category (Fig. 4.25).

Fig 4.25  Category selection window



Record Menu

The Record menu (Fig. 4.26) provides commands for creating, deleting and locating student
records ( by sequential and by search techniques). This menu also provides commands for
the disposition of inactive records placed in the archives (which are saved in a separate
archive, rather than being permanently lost when deleted).  The Archives command also
handles the disposition of duplicates and records removed by a drop/add action during the
term.

Fig 4.26  Record menu

4.31  New

Use New to create new, blank student records.

4.32  Delete

Use Delete to remove the displayed record. The deleted records are archived; therefore, the
equivalent of an undo command exists. Use the Archives command for the disposition of
deleted records.

4. 33  Search

Successful database usage depends upon convenient and rapid data retrieval. Sequential
retrieval by student name or identification is discussed in sections 4.34 through 4.37.
Retrieval in an arbitrary order is also necessary and is provided by this command.

Scroll to locate and to retrieve a record.

• Type command S to obtain the menu of names.

• Use the scroll bar at the right to find the name of the student whose record you wish to
retrieve, e.g., Speicher, M.



Fig 4.27  Scroll and double-click to select

• To retrieve the record, double-click on the desired name when it comes  
into view.

Notice that the cursor remains in the same field as you select different records. This
expedites the grade entry process.

Type a few leading characters to locate a record

• Type command S to obtain a menu of names again.



Fig 4.28a  Selection window

• Type So and press Return.

Note: Return accepts keyboard entries; Select accepts scroll bar entries.

• Double-click on Sobel, O to select that record.



Fig 4.28b  Narrowed list of names

Note: If you type enough characters to uniquely locate a record, MacRegistrar bypasses the
above screen.

Alternatively, you can click on Sobel, O and then on Select.

4.34 Previous

Display the immediately previous record.

4.35 Next

Display the immediately following record.

4.36 First

Display the first record in the file.

4.37 Last

Display the last record in the file.

4.38  Archives...

MacRegistrar saves in a separate list for manual review and disposition all deleted records
and all imported records (Sec. 4.7) for which it cannot find an exact match.



Fig 4.29  Archives window

Using the Archives... command, you can recover deleted records for review. Similarly,
when you update your class list using files supplied by the Registrar or when you import
scores from a text file created by a word processor or by a machine scoring device,
MacRegistrar froms an archive file of problem cases.

During a Create/Append operation duplicate names are counted in Matches (Fig 4.12) and
listed here (Fig 4.29). During a Drop/Add operation names in the course file which are not
in the update file will be listed as Drops. During an Import Grades operation names in the
import file which are not found in the course file data base are counted as Exceptions and are
listed in the Archives (Fig 4.29). Any of these records can be printed, retrieved or
permanently deleted using Archives... of the Record menu. If both names and CUIDs are
included in the course file and in the import file, records are matched by CUID and the first
three letters of the last name. If CUIDs are not included, only names are used to establish the
correspondence of records. You can retrieve, modify, or permanently purge exception file
records.



Scores Menu

Fig 4.30  Scores menu

4.39  New Item

To add new items (grade fields) at the end of any column of a particular student record,
select the last field in a column and then use New Item  of the Scores menu (Fig 4.30). The
new item remains undefined (and, therefore, shaded) until you assign a value directly or
import one. See New Global Items...  below.

4.40  Delete Item

You can select a field at the bottom of a column for a particular student record and then
delete it using the Delete Item command from this menu. See Delete Global Items...   below.

4.41  New Global Items

You can select a field at the bottom of a column and then add the corresponding field on all
existing records in the course file. This field will not be defined automatically for any
subsequently created records.

4.42  Delete Global Items

You can select a field at the bottom of a column and then remove it and   the corresponding
field on all records in the course file.

4.43  Drop Lowest...

The Drop Lowest...  option permits you to drop a specified number of the lowest grades in
each category when the program computes the weighted average.



Fig 4.31  Drop lowest score window

Alternatively, if you allow extra graded items, you can include only a specified number of
the best entries in each column using the Keep Best...  option.  Not all student records are
required to have the same fields defined; use Show Template...  of the Scores menu to
identify the fields which have been defined on at least one record in the course.

4.44  Letter Grades...

When you reformat a field from a numerical grade to letter grade, MacRegistrar makes an
automatic translation according to ranges established using the following table. This
translation table (Fig 4.32) is also used in calculating the weighted average when letter
grades have been recorded.



Fig 4.32  Letter grade transformation

Note: The upper limit of the grade range is used in a letter grade transformation, as
suggested by the downward curvature of the range markers in Fig 4.32.

Note: If you use the 0 - 4.3 range (Fig 4.33) to transform letter grades into a numerical value
for a weighted average calculation, don't forget to format the Final Grade field (Fig 4.37) to
have the same range.

Fig 4.33  Letter grade translation range
The range of values can be set to one of several popular choices with the Range button.
Select from the choices in Fig 4.33. Set the translation table by dragging the indicators on the
grade division boundaries; finer adjustments can be made by editing the values in the table
at the right.



4.45  Show Template...

When calculating the weighted average (using Calc. Average  under Special) you need to
know how to handle missing grades. Because not every student record need have the same
number of entries, you may need to identify which fields have been defined. Use Show
Template  to identify the defined fields.

Note: Defined records need not necessarily contain values. For example, the Lab and Paper
categories contain no values; every column, however, must contain at least one defined
field.

Fig 4.34  Template of defined fields

4.46  Format...

You can set the format for individually selected fields or for entire columns but you must
select a field before MacRegistrar can enable this option. You can use either integer or real
numbers with one decimal place; letter grades can be either A+, A, A-, B+, ...F or S/U or any
two characters.



Fig 4.35  Format of a grade field

If you attempt to reformat a field having existing data, MacRegistrar will warn you and then
transform the data (See 4.42).

Fig 4.36  Data conversion warning

4.47  Average Format...

The computed Average field can be either integer or decimal.



Fig 4.37  Format course average field

4.48  Grade Format...

The final course Grade also has a reserved field which you must format. The grade can be
either a numerical grade, a letter grade, or an S/U. You can edit the Grade you calculate
using the Special menu.

If “E” appears in the GrOpt field in the student information section of the screen and you
have selected Letter grades, MacRegistrar uses the S/U option for that record, overriding the
general designation. Likewise if “L” appears in that field, a letter grade overrides the general
choice. See the customization section in the Appendix.

Fig 4.38  Format final course grade



Special Menu

Fig 4.39  Special menu

4.49  Sort...

Fig 4.40  Select fields for listing and sorting



With List selected, specify the left-to-right ordering of the data columns by clicking. The
ordering is posted within each field selected. To exchange the order of any two selected
fields, use the mouse to drag one numbered field to coincide with another. To delete a
previously selected field click on it again. You can click in the boxes on the top row of Fig
4.40 to change heading names, and, if sorting by one of these fields, to choose the sort
categories.

Clicking in a heading or option-clicking in a selected field allows you to change headings or
divide a sorted list into categories.

After you have selected the fields, click on Sort and then specify one or two fields in which
you want to sort the records. You might click on TA and then on Student to produce an
alphabetical class list for each TA.

4.50  Rank...

Fig 4.41  Select input and output fields for ranking

Click on a grade field to identify the data you want to use in the rank. If more than one Rank
or Calc. field exists (See 4.38), you must also select the field to receive the calculated value.



4.51 Weights...

You need a formula for combining the individual scores if you are to produce a single score
for the course. We have implemented three popular approaches; however, you are not
limited to these.You can export the data to another application (e.g., spreadsheet, database,
statistical, or graphical) or to a program you have written.

The most popular approach to this calculation is the weighted average method   where
MacRegistrar internally converts each test item within a column to a decimal number
(using the point range you set for each entry when you formatted the field). Then
MacRegistrar weights the items within columns equally to obtain column averages.
MacRegistrar then weights the column averages to obtain a composite average. For example,
10% of the grade might be attributed to the average of the homework scores, 20% for the
average of the quizzes, 40% for a term project, and 30% for the comprehensive final exam.
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All the Greek sigma symbols should be highlighted; if they are not, click them now.

Click one of the arrows at the top left of the screen to initialize the weight assignments; then
drag the small circular dots to allocate the weights. These weights always total 100%.

Fig 4.42  Assign column weights for average calculation



Another variation on this method is to base each item within a column on a different point
total. Click the weight symbols just above the Greek sigmas (Fig 4.43), and then you can enter
integer weighting values for each entry. You need only assign numbers which preserve the
correct weighting ratios among the items within each column.

In Fig 4.43 the score is based solely upon six papers; the final three papers count twice as
much as the first three.

Fig 4.43  Unequal points for each field

4.52  Calc. Ave...

Fig 4.44  Select weighting scheme

MacRegistrar provides two popular schemes for computing a a composite term score:
weighted average and the normalized Z scores.

Weighted Average: The weighted average method handles both schemes for finding a
column average described in the previous section: equal and unequal weights.



equal weights:
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unequal weights:
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The average calculations depend upon the existence of complete student records in the
course file (See 4.48.). Three options for dealing with incomplete records are available.

Numerical examples:

If the course grade is based solely upon six papers having grades of 70, 75, 80, 85, 90, and 95
and all scores were weighted equally, the weighted average is 82.5.

If the last score of 95 is missing and you use the option give no credit for missing score, the
95 becomes  a 0 and the average is 66.7. If you use the option give full credit for missing
score, the average is based on the remaining five scores and the average of 80.0. If you use
the option assign averages of 0 the average is 0, making such records easily located for
review using the Sort... command..

Suppose all six scores are present and weighted unequally, as indicated in Fig 4.43. Then
wt_ave = 1.00 * [1 * 70 + 1* 75 + 1*80 + 2*85 + 2*90 + 2*95] / [1+1+1+2+2+2] = 85.0.

Normalized Scores: The normalized method, available only if all scores within a column
are weighted equally, takes the class distribution of scores into account. You can activate this
option only if you have selected all six of the weight symbols above the capital sigmas in the
weights window.

The normalized score is defined as follows:

normalized score  =  Z = 
student_score_sum  − mean_student_sum
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Numerical example:

Suppose three students have the following scores:

Score1Score2 Total
100 90 190
66 77 143
75 85 160

mean_student_sum = (190+143+160)/3 = 493 / 3 = 164.3

std_dev_student_sum = 
(190−164.3)2+(143−164.3)2+(160−164.3)2

3−1
 = 23.8

Totally Random: The third choice actually simulates the process students sometimes
cynically assume professors use—the stair step method—in which the final grade is
determined by the relative resting place of each paper when the professor throws the stack
down the stairwell. Just a bit of humor, of course.

4.53  Calc. Grade...

You can easily handle the transformation of the weighted average into a final course letter
grade by this command.

Fig 4.45  No initial grade assignments



The assignment process begins with a list of names, weighted averages, and an initial grade
assignment arranged in a list according to weighted average. The initial assignments can be
either *, as above, distributed uniformly, or based upon the Letter Grades... assignment
(§4.43). Use the reset icons to choose the starting configuration.

Simply drag the category separation lines to adjust membership in each range (Fig 4.45).
MacRegistrar immediately upgrades the new grade on the screen. Adjust these lines as often
as needed to achieve the desired assignments. You can change the actual ordering of names
simply by dragging a name to a new position in the list.

The number of grades in each category, the cummulative number having one particular
grade or a higher grade, and the numerical range corresponding to one particular grade
appear at the right.

Fig 4.46  Visually reassign grades

Scroll the list as needed using the scroll bar; automatic scrolling occurs when you drag a
name or category separator past the end of the visible range. MacRegistrar automatically
assigns the Grades to the student records when you click OK.



Fig 4.47  Uniform initial distribution of grades

If you wish to review a student’s full record at any time during the grade assignment
process, simply double-click  on the student's name and the record appears.



Fig 4.48  Full record lookup

During the grade assignment process you still have access to the full text record of a student
normally found using the About Student... command on the  menu. Option double-click
on the name to retrieve the student's full record.

4.54  Create Graph...

Descriptive statistics (mean and standard deviation) and histograms provide an overall
view of the distribution of scores. These characterizations are immediately available from
MacRegistrar.

To create a histogram, click to designate up to six score fields having the same  format you
wish to examine and then choose Create Graph... from the Special menu. MacRegistrar can
also construct histograms of scores separated by categories (TA, Cl, Col, Lec, Lab, or Sec).

From Fig 4.51 select the options which describe the plot you wish to create. Line drawings
with mean and median are only available for letter grade fields. You can create a histogram
for either numerical or letter grade fields. The range for the horizontal axis defaults to the
range specified in the Format... command. However, you can specify a smaller range if you
wish.

You can choose either stacked or side-by-side charts. Up to six comparisons can appear on
one graph. Use the choose window (Fig 4.57) to select the categories you want to compare. A
legend to identify the categories appears automatically on the graph.



Fig 4.49  Histogram with two categories

Click on the icon at the bottom right corner of the graph to see the following descriptive
statistics.

Fig 4.50  Descriptive statistics



Click on the histogram icon to return to the graph or click on the close box to exit Create
Graph.

4.55  Graph Options...

You can access Graph Options...  directly from the Special menu as well as from within the
Create Graph... option..

Fig 4.51  Graph options window

When multiple sets of data have been selected, a scroll selection window appears as part of
this window. Use the Macintosh conventions of shift-clicking and option clicking to select a
continguous or a disconnected range.

4.56  Assign Comment....

You can create up to five stock comments to annotate grade fields and tag up to five fields of
each student record with any combination of these messages. Simply select a field you want
to tag, access the Assign Comment... command from the Special menu, select the
appropriate message, and click OK.



Fig 4.52  Assign comment window

To review the comments assigned for a student, retrieve the student record and select
Assign Comment... to see a list such as above.

4.57  Change Headings...

You can customize the column headings for your particular course. Select Change
Headings... from the Special menu. You can modify all of the seven heading. Click OK to
accept the list when editing is complete.

Fig 4.53  Change column headings



4.58  Change Password...

You can change the password at anytime, provided of course you know the existing
password and can open the file. The password provides a low level of security from casual
snooping but is not sufficient to prevent a serious attempt to access your files. We
recommend that you exercise the same level of security you would with paper copies, i.e.,
physical security. Incidentally, we recommend that you both duplicate disks for backup and
print a summary after each major update.

Fig 4.54  Set password window

4.59  Change Course Info...

Course information is stored here.  If you intend to submit your end-of-term course grades
in machine readable form, the Registrar field must match the expected course identification.
Therefore, if you attempt to alter the information assigned to this field by the Import From
Registrar (Fig 2.75) process, an alert reminds you of this requirement.

Fig 4.55  Course information window



4.60  Generate ID's...

Federal law prohibits the public disclosure of such student information as class lists without
the student's consent. The student's identification or social security numbers might be used
instead of the student's name. However, MacRegistrar provides an even more secure
procedure—internal course identification numbers. MacRegistrar generates this course-
specific number automatically. Without destroying the numbers created earlier, you can
even generate unique IntId numbers for students joining the class after the term has begun.

Fig 4.56  Internal identification number window



Windows Menu

Fig 4.57  Windows menu

4.61  Student

 The Student window contains the complete student record. Because additional windows
exist (See 4.59-61), clicking the close box does not close a course file. You can make the
student record window active or inactive by using the Windows menu or by clicking on
other windows.

Fig 4.58  Student record window



4.62  Field Info

You can describe the contents of each field using this window. A description of the material
covered by the score is a customary use of this field. If you maintain attendance records in
the database, you might use this field to associate the day of the month with each entry.

Fig 4.59  Field info window

4.63  Sorted List

You can generate a sorted list using the Sort... of the Special menu. If another window
subsequently becomes the active window, you can bring the sorted list to the foreground
again with Sorted List command of the Windows menu. Clicking on any visible portion of
the window has the same effect.

Fig 4.60  A sorted list window

4.64  Graph

To generate a graph use Create Graph...  of the Special menu. If another window
subsequently becomes the active window, you can bring the graph to the foreground again
with the Graph   command of the Windows menu. Clicking on any visible portion of the
window has the same effect. You can toggle between graph and descriptive statistics
windows using the small icon at the bottom right corner of the window.



Fig 4.61  Graph window

4.65  Fonts. ..

The entire collection of fonts and font sizes in the active system file are available for use
with the text on the screen or in printed output for sorted lists. If you enter a font size not
included in the scroll menu, the quality of screen and ImageWriter output suffers;
LaserWriter output, however, is scaled correctly and is of higher quality.

Fig 4.62  Fonts...  window



Appendix

5.1  Customization Guide

A. Screen Appearance

You can make three adjustments to the appearance of the student record window.

1.  Location of text on the screen:

MR stores screen locations in 9 named resources of type 'SLoc'. This resource is made up of
an integer that gives the vertical location of the start of the text and a list of integers that give
the horizontal locations of each of the strings that MR draws on the screen.

Make adjustments as follows:

SLoc "HR1", ID 128

First row of the student information; pairs of integers are given. The first of each pair is the
location of the field name, and the second is the location of the beginning of the editable
portion of the field.

SLoc "HR2", ID 129

Second row of the student information in the same format as "HR1".

SLoc "Headings", ID 130

Nine items giving the location of the column headings, including column # and Average.
The locations are the centers of the strings.

SLoc "First Row", ID = 131

One item giving the location of the centers of the first row of the score fields. The remaining
rows are offset from this row.

SLoc "Grade", ID = 132

Center of the Grade field.

SLoc "Students", ID = 133

Center of the Students field.

SLoc "Lines1", "Lines2" and "DArrow"

Used for drawing lines and the Category Arrow.



2. Width of editable fields:

MR stores field widths (in pixels) in the resource type 'FWdt' ID# 128. An integer exists for
each of the fields in the student information portion of the student record window (12). The
13th integer is the width of the score fields, including grade and average.

3. Field names:

MR stores field names as strings in the resource type 'STR#'.
STR# 1000 is the default column headings. STR# 1001 contains the student information
field names. MR also stores this information in STR# 128. The description of these fields is
stored in STR# 2001. STR# 1002 contains the remaining strings on the screen.

B. Keyboard Traps

You can control two things regarding keyboard entrys:

1. Number of allowable characters:

FWdt # 129 contains a table of maximum character counts for each of the 12 fields in the
student information portion of the student record window. The 13th integer is the character
count for the score, average, and grade fields.

2. Type of input allowed:

FWdt $ 130 contains a table of allowable inputs for each of the 12 fields in the student
information portion of the student record window. MR assigns a character in the table with
one of the following values to each field:

A Alphabetical; also includes ' ', ',', '-', and '!'.
N Numeric; '0' to '9' and '.'
B Both Alphabetical and Numeric

Any other value in the table other than these means that the field can contain any character.

C.  Grade Option Character Definition

FWdt # 131 contains a 3-character table of the symbols used to denote the grade options as
follows:

Char 0 Letter Grade Option
Char 1 S/U Grade Option
Char 2 Number Grade Option

When one of these characters appears in the grade option field, then the grade for that
student is forced to the format of the grade option.



D.  Term Dialog

DITL # 611 is the item list for the Term Dialog. The last n  items in this list are the control
items for the various terms used. You can configure this item list for as many radio buttons
as you need, as long as they are in consecutive order and are the last items in the list. The
strings that MR stores in the export file for each of the items are stored in STR# 611. Make
sure that the number of radio buttons in the item list equals the number of strings in the
string list.

E.  Letter Grades

STR# 129 contains the letter grade strings MR uses.

F. Import/Export Fields

STR# 600 contains the names of the fields that appear in the menu bar when you are
creating or editing an import or export format.
The allowable contents of these fields which MR checks during import are contained in the
same table as Keyboard Traps.

5.2  Sample Calculations in Pascal

PROGRAM SumScores;

{This program is an example designed to demonstrate how one might use}
{the import/export capabilities of MacRegistrar to implement user-   }
{defined calculations on scores. It will also demonstrate the use of }
{the import/export header as means of identifying the fields that are}
{contained in the export file.}

{Specifically, this program takes an arbitrary number of score fields}
{for each student, and adds them to form a sum column. The number of }
{score fields is determined from the export header. The exported     }
{score fields are replaced with the field sums.}

USES
Memtypes, Quickdraw, OSIntf, ToolIntf, PackIntf, SANE;

{ Typical application initialization }

PROCEDURE Initialize;

{ Maximum application heap zone with a program-defined stack }

PROCEDURE SetUpMemory;

CONST
maxStackSize = 20000;

TYPE
MemPtr = ^longint;



VAR
stackBasePtr : MemPtr;

BEGIN { SetUpMemory }
stackBasePtr := MemPtr($908);
SetApplLimit(pointer(stackBasePtr^ - maxStackSize));
MaxApplZone

END; { SetUpMemory }

BEGIN
SetUpMemory;
InitGraf(@thePort);
InitFonts;
InitWindows;
InitMenus;
TEInit;
InitDialogs(NIL)

END; { Initialize }

PROCEDURE Main;

VAR
theTypeList : SFTypeList;
ImpDlgPt : Point;
ImportFile  : SFReply;
FileError : OSErr;
IFRef,
OFRef,
NFields,
FieldStart  : integer;
logEOF,
count : longint;
OutFile : string[63];
Header : Handle;
HeaderString : CharsHandle;
BadFormat,
Delimited : boolean;
Delimiter : char;

{ Convert an integer into a string }

FUNCTION IntStrOf ( i : integer ) : Str255;

VAR
f : DecForm;
s : DecStr;
d : decimal;

BEGIN
f.style := FixedDecimal;
f.digits := 0;
Num2Dec(f, i, d);
Dec2Str(f, d, s);
IntStrOf := s

END; { IntStrOf }

{ Convert a numeric string into an integer }

FUNCTION IntNumOf ( str : Str255 ) : integer;



VAR
n : longint;
NChars : integer;

BEGIN
NChars := 1;
WHILE (str[NChars] IN ['0'..'9']) AND (NChars < length(str)) DO
NChars := NChars + 1;

IF NChars < length(str) THEN
NChars := NChars - 1

ELSE IF str[NChars] = ' ' THEN
NChars := NChars - 1;

str := copy(str, 1, NChars);
StringToNum(str, n);
IntNumOf := LoWord(n)

END; { IntNumOf }

{ Return TRUE if at end of file }

FUNCTION EOF : boolean;

VAR
fPos : longint;

BEGIN
FileError := GetFPos(IFRef, fPos);
EOF := fPos >= logEOF

END; { EOF }

{ Return the next character in the file. The file mark is moved.}

FUNCTION NextChar : char;

VAR
c : char;
count : longint;

BEGIN
count := 1;
c := ' ';
FileError := FSRead(IFRef, count, pointer(ord(@c) + 1));
NextChar := c

END; { NextChar }

{ Check the file for a format header at the beginning. If found }
{ then return a handle to it. }

FUNCTION IsHeader ( VAR Header    : Handle;
VAR BadFormat : boolean ) : boolean;

VAR
Switch : STRING[2];
fPos  : longint;

BEGIN
IsHeader := false;
BadFormat := false;
FileError := SetFPos(IFRef, fsFromStart, 0);



count := 2;
Switch := '  ';
FileError := FSRead(IFRef, count, pointer(ord(@Switch) + 1));
IF Switch = '%%' THEN
BEGIN
WHILE (NextChar <> '%') AND NOT EOF DO
;

IF NOT EOF THEN
IF NextChar = '%' THEN
BEGIN
FileError := GetFPos(IFRef, fPos);
Header := NewHandle(fPos);
HLock(Header);
FileError := SetFPos(IFRef, fsFromStart, 0);
count := fPos;
FileError := FSRead(IFRef, count, Header^);
HUnlock(Header);
FileError := SetFPos(IFRef, fsFromStart, fPos + 1);
IsHeader := true

END
ELSE
BadFormat := true

ELSE
BadFormat := true

END { if }
ELSE
FileError := SetFPos(IFRef, fsFromStart, 0);

IF BadFormat THEN { Bad format header. Probably missing %%. }
SysBeep(6)

END; { IsHeader }

{ Return an integer equivalent to the two-character stringstored}
{ at 'StartingIndex' in the header handle. }

FUNCTION ExtractInteger ( StartingIndex : integer ) : integer;

BEGIN
ExtractInteger := 10 * ( ord(HeaderString^^[StartingIndex]) - 
$30 ) + ord(HeaderString^^[StartingIndex + 1]) - $30

END; { ExtractInteger }

{ This procedure reads the input file for a list of names and  }
{ scores, andputs the names and the sum of the scores in the   } 

{ output file. }

PROCEDURE DoAdd;

VAR
FieldIndex,
FieldCount,
FieldLength,
Sum,
Code : integer;

aField   : Str255;
dummy : char;



{ Read the next field from the file. }

FUNCTION ExtractField : Str255;

VAR
str : Str255;
l : integer;
c : char;
count : longint;

BEGIN
IF Delimited THEN
BEGIN
l := 0;
{ Read characters one at a time until a delimiter, end 
{of line, or end of file. }

REPEAT
c := NextChar;
IF (c <> Delimiter) AND (c <> chr(13)) THEN
BEGIN
l := l + 1;
BlockMove(pointer(ord(@c) + 1), pointer(ord(@str) 
+ l), 1)

END
UNTIL (c = Delimiter) OR (c = chr(13)) OR EOF;
BlockMove(pointer(ord(@l) + 1), @str, 1)

END
ELSE
BEGIN
{ Read the # of characters specified in the format. }
FieldLength := ExtractInteger(FieldIndex);
FieldIndex := FieldIndex + 2;
BlockMove(pointer(ord(@FieldLength) + 1), @str, 1);
count := FieldLength;
FileError := FSRead(IFRef, count, pointer(ord(@str) + 1))

END;
ExtractField := str

END; { ExtractField }

{ Write a character to the output file }
PROCEDURE WriteChar ( aChar : char );

VAR
count : longint;

BEGIN
count := 1;
FileError := FSWrite(OFRef, count, pointer(ord(@aChar) + 1))

END; { WriteChar }

{ Write a string to the output file }

PROCEDURE WriteField ( field : Str255 );

CONST
spaces = '                         ';

VAR
count : longint;



BEGIN
IF Delimited THEN
BEGIN
count := length(field);
FileError := FSWrite(OFRef, count, pointer(ord(@field) +

1));
IF FieldCount < NFields THEN WriteChar(Delimiter)

END
ELSE
BEGIN
IF length(field) < FieldLength THEN
field := concat(field, copy(spaces, 1, FieldLength - 

length(field)))
ELSE IF length(field) > FieldLength THEN
field := copy(field, 1, FieldLength);

count := FieldLength;
FileError := FSWrite(OFRef, count, pointer(ord(@field) + 1));

END
END; { WriteField }

BEGIN { DoAdd }
FieldIndex := FieldStart;
FieldCount := 1;
Sum := 0;
WHILE NOT EOF DO
BEGIN
Code := ExtractInteger(FieldIndex);
FieldIndex := FieldIndex + 2;
aField := ExtractField;
IF FieldCount = 1 THEN
WriteField(aField)

ELSE
Sum := Sum + IntNumOf(aField);

{ NOTE: No check is made to see if data is actually score} 

{data in the right format }
IF FieldCount = NFields THEN
BEGIN
IF NOT Delimited THEN
dummy := NextChar;

FieldIndex := FieldStart;
FieldCount := 1;
WriteField(IntStrOf(Sum));
WriteChar(chr(13));
Sum := 0

END
ELSE
BEGIN
IF Code = 13 THEN
FieldIndex := FieldIndex + 4;

FieldCount := FieldCount + 1
END

END { while }
END; { DoAdd }

BEGIN { Main }
theTypeList[0] := 'TEXT';
SetPt(ImpDlgPt, 100, 100);
SFGetFile(ImpDlgPt, '', NIL, 1, theTypeList, NIL, ImportFile);



WITH ImportFile DO
IF good THEN
BEGIN
FileError := FSOpen(fName, vRefNum, IFRef);
FileError := GetEOF(IFRef, logEOF);
IF IsHeader(Header, BadFormat) THEN
BEGIN
HeaderString := CharsHandle(Header);
Delimited := HeaderString^^[3] = 'd';
NFields := ExtractInteger(6);
IF Delimited THEN
BEGIN
FieldStart := 10;
Delimiter := chr(ExtractInteger(8))

END
ELSE FieldStart := 8;
{ 'FieldStart' is the beginning of the field part of } 

{ the file, i.e real data }
IF NFields > 1 THEN
 { need more than one field because name is field # 1}
BEGIN
OutFile := concat(fname, '.sum');
FileError := FSOpen(OutFile, vRefNum, OFRef);
IF FileError <> noErr THEN

BEGIN

FileError := Create(OutFile, vRefNum, '????', 'TEXT');

FileError := FSOpen(OutFile, vRefNum, OFRef)
END;

FileError := SetEOF(OFRef, 0);
DoAdd

END
ELSE SysBeep(6) { plus perhaps an alert }

END
ELSE SysBeep(6); { plus perhaps an alert }
FileError := FSClose(OFRef);
FileError := FSClose(IFRef);
FileError := FlushVol(NIL, vRefNum)

END { with, if }
END; { Main }

BEGIN { SumScores }
Initialize;
Main

END. { SumScores }



5.3  Format of Import/Export Header

The header is a continuous string of ASCII bytes preceded and followed by '%%'. Spaces and
carriage returns are ignored, allowing the header to span more than one line.

Field Information:

If delimited then there are two bytes containing the delimiting character’s ASCII code. Then,
for each field there is a two byte code. If fixed-width then for each field there is a two-byte
code followed by two bytes for the length of the field.

Codes:
Name 00
ID 01
SSN 02
IntID 03
TA 04
Class 05
College 06
Lecture 07
Lab 08
Section 09
Credit 10
GrOpt 11
Prompt 12 If importing, then this field will be. If exporting, then

you will be prompted for this information.
Mark 13 Followed by two bytes for the row and two for the

column.
Average 14
Grade 15
Instructor Name 16
Course College 17
Department Code 18
Course Number 19



Year 20 last two digits
SRRS Section Type 21 '1' if 'Lec'

'2' if 'Lab'
'3' if 'Sec'
'C' if course is graded by course
'I' if course is graded by individual

SRRS Section # 22 The numeric section number or blanks if course is
graded by course or individual

Blank 23
Term 24 'FA' for Fall or 'SP' for Spring

Standard Import/Export headers are stored in the application’s resource

Import:

Initial course information from Registrar
ID = 1200, Name = 'Standard Import from Registrar'

Course update - Drop/Add
ID = 1300, Name = 'Drop/Add'

Export:

Final to Registrar
ID = 200, Name = 'Standard Export to Registrar'



(Click on a menu command
 to go to its description.)
Pull-down menus
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